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Chapter 1. Proficy Authentication

About Proficy Authentication

Proficy Authentication (UAA) provides identity-based security for Proficy based applications and APls. It
supports open standards for authentication and authorization, including OAuth2. Proficy Authentication
is designed to operate on a cloud-native architecture, aligning with Cloud Foundry's principles for agility
and efficiency. Visit Cloud foundry for more information. Organizations can easily deploy, manage, and
scale Proficy Authentication within the Cloud Foundry environment, streamlining the operational aspects
of authentication and access management. The application also offers a secure and efficient user

authentication experience, making it ideal for mission-critical applications where reliability is paramount.

Several Proficy products use Proficy Authentication, including Historian, Plant Applications, and
Operations Hub. You can configure Proficy Authentication from within Configuration Hub.

Proficy products can share an existing common Proficy Authentication (UAA) instance, which allows for
all products to use a central User store for authentication and authorization.

Proficy Authentication can be configured to collaborate with external identity providers that use these two

common protocols:

« Lightweight Directory Access Protocol (LDAP)
« Security Assertion Markup Language (SAML)

When Proficy Authentication is integrated with an external identity provider, it enables users and groups
managed by that provider to access Proficy products and features. This means that the authentication
and authorization established by the external identity provider extend to various services within the

ecosystem.

OAuth is designed as an authorization protocol permitting a user to share access to specific resources

with a service provider.

Benefits of using OAuth:

* Enables third-party application access
« Controlled access to APIs

- Adaptable and flexible user interactions

Set up Proficy Authentication

This topic describes how to set up Proficy Authentication in Configuration Hub.


https://docs.cloudfoundry.org/concepts/overview.html
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The following steps describe how to set up Proficy Authentication in Configuration Hub. Setting up
authentication provides access to all the products (Historian, iFIX) registered with Configuration Hub. You
use the same Proficy Authentication server to authenticate.

-
1. Double-click desktop icon to launch the Configuration Hub application.
2. Select Setup Authentication.

Configuration Hub Login @

Authentication Source not configured Chck setup below to configure

Setup Authentication

The Configuration Hub Administrator Credentials screen appears.
3. Enter the details for logging in to the Configuration Hub application.

Field Description
Client ID The client ID provided during installing Configuration Hub. Example: con-
fi ghubadm n
Client Secret The client secret provided during installing Configuration Hub.
Configuration Hub Administrator Credentials X
confighubadmin
........ ]
MNOTE: Use the credentials created during the install process.

4. Select Verify.
If the credentials are correct, the Register with Proficy Authentication screen appears.
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5. Provide these details to configure the Proficy Authentication application.

These fields are populated automatically if you opted for installing Proficy Authentication along

with Configuration Hub. You have the option to edit and update the details.

Field

Description

Server Name (Fully
Qualified Name)

The host name of the machine where Proficy Authentication is installed.

Enter a fully qualified domain name. For example, deskt op- sahf g5f . | ogon-

. ds. ge.com

Refer to step 6 to establish a trust with this server connection.

Server Port

The port number to communicate with the host machine. The default port

where UAA is installed is 443.

The server connection is automatically tested on entering the port. You
can also select Test to test the connection.

Use Configuration
Hub Administration
credentials for Profi-

cy Authentication

Select this check box to populate the same login credentials you entered

for Configuration Hub Admin account.

If you want to use unique login credentials for Proficy Authentication,
clear the check box and enter CLIENT ID and CLIENT SECRET.

Client ID

The administrator client identifier that has permission (authority) to log in
to Proficy Authentication.

Client Secret

The administrator client secret to log in to Proficy Authentication.
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Register with Proficy Authentication bd
SERVER MAME (FULLY QUALIFIED NAME)

sachinauthguardiamymO1.htclab.ge.com

SERVER PORT

443

Test Server Connection

Proficy Authentication Credentials

+ | Use Configuration Hub Administration credentials for Proficy Authentication

CLIENT ID

CLIENT SECRET

MOTE: Use the credentials created during the install process.

Register

6. Select Not trusted to establish a trust connection between Configuration Hub and Proficy
Authentication.
The Certificate Details screen appears.
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Certificate Details

Attribute Name Root Certificate

Subject CH=5ACHINAUTHGUARD Root CA 202112241544, OU=0perations Hub Site,
0=GE Customer

Thumbprint OBEBESFDALT2CIDCFTABCARF12T085EF1338119C

Serial Number IFETECCITI2CHAG9

Issuer CH=SACHINAUTHGUARD Root CA 202112241544, OU=0perations Hub Site,
0=GE Customer

Valid From 2021-12-24 00:00:00 GMT

Valid To 2026-12-23 00:00:00 GMT

Don't Trust m

7. Select Trust.

The trusted certificate(s) are added to the windows store on the machine where Configuration Hub
is installed.
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Register with Proficy Authentication pe
SERVER MAME (FULLY QUALIFIED MAME)
sachinauthguardianvm01.htclab.ge.com @ Sl

SERVER PORT

443

Test Server Connection

Proficy Authentication Credentials

| Lse Configuration Hub Administration credentials for Proficy Authentication

CLIEMT ID

CLIENT SECRET

NOTE: Use the credentials created during the install process.

Register

8. Select Register.
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Register with Proficy Authentication x

A default user ch_admin is created with password same as
FProficy Authentication secret, please use this to continue to login

9. Select Ok.

Ok

The Configuration Hub Login screen appears.

Configuration Hub is set up as a client for Proficy Authentication. The following default user is created to

log in to the Configuration Hub application.

User ID

Password

ch_adm n

The client secret you entered for Proficy Authentication.

Log in to Configuration Hub and perform operations related to Proficy Authentication.

Get Started With Proficy Authentication

This topic helps you to get started with the application.

Proficy Authentication provides identity-based security for Proficy based applications and APIs.

You can perform the following tasks in Proficy Authentication:
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« Configure UAA/LDAP (on page 15)/SAML (on page 24) identity providers

« Create new user accounts (on page 67)

- Create new group accounts (on page 58) and add users/other groups as members
« Perform UAA/LDAP/SAML group mapping (on page 61)

Task Roadmap

The roadmap is designed to guide you through a sequence of task workflows within Proficy
Authentication.

# Task Description
1 Install and set up Proficy Authenti- | Set up Proficy Authentication (on page 4)
cation.
2 Enhance security by implementing | Enable Multi-Factor Authentication (on page 48)

multi-factor authentication.

3 (Optional) For seamless user expe- | Windows Integrated Authentication / Auto-login (on page
rience, consider implementing au- | 73)

to-login. But make sure that your
system operates within a trusted
network to reduce the risk of unau-
thorized access.

4 (Optional) For continuous, reliable, | Configure High Availability for Proficy Authentication (on
and scalable access to authenti- page 89)
cation and authorization systems,

consider implementing high avail-

ability.

5 Define scopes and permissions to | Overview of Managing Groups in Proficy Authentication
control access to resources. (on page 52)

6 Develop a backup and recovery Backup and Restore (on page 119)

plan to ensure data integrity and

availability.

Check Installed Version

To check the version of the Proficy Authentication application within Configuration Hub, select the
application name on the NAVIGATION menu. The version information appears under DETAILS.
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The following screenshot shows Proficy Authentication 2024 installed, highlighting its specific build

version.

NAVIGATION
A

/ \
. > m proficy Authentication /

W Administration

Show or Hide Data Columns

DETAILS

Proficy Authentication

Q_ search
Field Value

~ GEMERAL
MName Proficy Authenti...
Version 4.0.914.0

Customize the display of data by choosing which columns to display and which to hide. You can show or

hide columns based on your needs, making it easier to focus on relevant information and de-clutter the

display.

NAVIGATION i@l Security-Proficy Authentication

Identity Provider

v = Proficy Auth... Graups

P Security

Q_ search
@ custom la..
Identity Providers T
= Administrati.. Idap

uaa

Users

DETAILS x

e+ @

Type Action / Calumn Choaser

dap

Column Chooser =

Identity Providers

v| Type
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1. Select {{E} for the respective data. The Column Chooser dialog appears with a list of available
columns.

2. Select the check box for the column you want to show. To hide a column, clear its check box.

3. Close the dialog to apply the changes.

Sort by Columns

Use the sorting option to sort data in columns by ascending or descending order. When dealing with large
datasets, it is easier to analyze, compare, and understand the information when the data is organized in a
meaningful way. The sorting option appears when you select a data column.

NAVIGATION bl Security-Proficy Authentication DETAILS
~ = Proficy Auth.. Identity Provider  Groups Users
P Security
Q, Search / 2 + o
@ custom la...
Identity Providers T Type Action
m Administrati.. Idap dap
uaa uaa

* Select T to sort data in an ascending order.

* Select l to sort data in a descending order.

Filter by Columns

Use the filter option to narrow down a dataset and focus on specific information. The filtering option
appears next to each data column.
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NAVIGATION @l Security-Proficy Authentication DETAILS

~ & Proficy Authentication dentity Provider  Groups  Users

P Security )
Q, Search = + &

@ Custom labels K K
User Name | Email

| Administration ch_admin ch_admin@test.org

OphubAdmin admin_17080057 24@your.dc
StudioAdmin igp@whbo.cajp

1. Select the filter icon for the data you want to filter. A screen appears with a list of existing data in
that column.

2. Select the check box for the data you want to filter.

To undo filtering, you can Select All.

3. Select OK to apply.

Search with Keywords

Use the search option to search within a dataset using keywords or specific terms that match with the
existing accounts in Proficy Authentication. You can also filter account details using search keywords.



NAVIGATION

Vv 8 Proficy Authentication
T Security
@ custom labels

| Administration

Manage Identity Providers

LDAP

Pl Security-Proficy Authentication

Identity Provider ~ Groups
— --._\
.j/ Q, search )
N A

Idenﬁ;yﬁjv;ﬂers 1

Idap

Add LDAP Identity Provider

This topic describes how to add a LDAP account in Proficy Authentication.
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Users

DETAILS X
uza
( /5:_563.?5-"? _ \\.
N -/
_Zl_e :_ - Value
~  ADMINISTRATOR CREDENTIALS T
ClientID confighubadmin
~  MFA
Disabled )

Authenticator

~ LIAA META DATA INFO
URL
Assertion Consum..
Entity ID

Single Logout Servi..

Log in to Configuration Hub with user/client having write access for admin and clients.

You can add multiple LDAP connections.

1. Go to Proficy Authentication > Security > Identity Provider.

2. Select _I_ and then select LDAP.

Security-Proficy Authent

ication

Identity Provider roups  Users

Q. Search

Identity Providers |

Google Au.. -

&
(0
+ &
SAML

Okta Login Station

uaa

The LDAP Identity Provider screen appears.

saml|

uaa
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3. Enter the following details:

Field Description
Name A unique name to help identify your LDAP connection.
URL The URL of the LDAP server. The trailing slash (/) must be included at

the end of the URL.

You can use LDAP with or without secure authentication in the follow-
ing format:

o Insecure port: | dap: // 100. 100. 100. 2: 389/

o Secure port: | daps: //100. 100. 100. 2: 636/

! Important:
In a URL address, ensure that | dap is in lowercase. Using up-
percase letters will render the address non-functional.

You can also use a fully qualified domain name instead of an IP ad-
dress.

For a secure port, provide user credentials.

Name

Bind User Distinguished

This is a distinguished LDAP user name to represent various entities
within an LDAP directory hierarchy, including users, groups, and orga-

nizational units.

The canonical format consists of CN (Common Name), DC (Do-
main Component), and OU (Organization Unit Name). CN and DC are
mandatory, while OU is optional.

Enter the LDAP Distinguished Name in compliance with LDAP stan-
dards to ensure proper processing by the system. In the following ex-
ample, each component (CN, OU, DC) is correctly formatted, separat-
ed by commas without any spaces, and is case sensitive.

CN=John Sni t h, QU=Fact or y, DC=Conpany, DC=COM

Play the video: How to retrieve the User Distinguished Name re-
qguired for establishing or modifying the LDAP connection

video/LDAP_UserDistinguishedName.mp4



video/LDAP_UserDistinguishedName.mp4
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Field Description

Password The password to log in to the LDAP server if you choose secure au-
thentication.

Test Tests the connection to the LDAP server. If the URL and login details
are correct, you will receive a test successful message.

Skip SSL Verification This option appears only when you choose a secure port for LDAP.

Select this check box if you want to skip establishing a secure con-

nection between client and server for exchanging LDAP data.

Clear the check box to allow SSL verification. Refer to step 4.

LDAP Identity Provider

Test Cancel Save

4. If you choose to secure LDAP, select I for SSL verification.

A message appears when the security certificate is trusted and added to the store.

In case the certificate is not added automatically, the following message appears.
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Certificate cannct be retrieved
Please use the browse utton below to select the server certificate

Select Browse to navigate and choose the server certificate from your local system.

&

5. Optional: Select next to the lock icon to view the certificate.

certAttributeMName Root Certificate

certSubject CH = CWARIRSSVRZK19.pa.com

certThumbprint 4123FCE4421BBEAL 3846CBFSACSEERT ZBSBOZATE

certSerialNumber  SE00000002F TOODEEE5058 1AFDOOOO0O000002

certissuer DC = com,pa CN = CWARIRSSVRZK1S.pa.com
certValidFrom Junm 21 18:28:08 2021 GMT
certValidTe Jum 21 18:28:08 2022 GMT

Close
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6. Select Save.

LDAP Identity Provider

Mame*®

CWARIRSSVRZK191

URL®
daps[CWARIRSSVRZK19.pa.com:6 36 5 @

Bind User Distinguished Name *
CH=saching CH=Users,DC=htcophub, DC=interna

Password *

Skip SSL Verification

Tact Cancel Save

Modify LDAP Identity Provider

This topic describes how to modify the existing details for the LDAP account.

Add LDAP Identity Provider (on page 15)

1. Log in to Configuration Hub as an administrator.
2. Go to Proficy Authentication > Security > Identity Provider.
The existing list of identity providers appear.
3. Select the LDAP identity provider.
The existing information for the identity provider appears on the DETAILS panel.

4. To modify the GENERAL details, select EJH to open a pop-up screen with the existing information.
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>

CWARIRS5VRZK1D

G\ T,

s GENERAL

URL®

CWARIRSSWVEZK1S

vy (CWARIRSSVRZK 19 pa.come 389

ientestuser,CN=Users, D =pa, ..

CWARIRSSWVRZKLS

LS

=rPPrinic pa Mame: _I':

5. If you modify any existing information, save the changes.

The general details are required to configure LDAP authentication.
6. To modify OTHER SEARCH CRITERIA details, place your cursor and enter the new value for the

respective criteria.

“ OTHER SEARCH CRITERIA

Group Base
User Base
User Filter
Group Filter

Max Filter

DC=pa,DC=co..,
DC=pa,DC=co..
icng (V)]
member={0}

10

Use these settings to enable the sub-directories in your search criteria.

Search Criteria

Example Value

Description

Group Base

OU=Sal es, OU=G oups, OU=En-

terpri se, DC=conpany, DC=com

Defines the starting point for the LDAP group
search in the active directory tree.
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Search Criteria Example Value Description

> CN is Common Name (required)

o DC is Domain Component (required)

> OU is Organization Unit Name (option-
al)

(L ™
Note:
If you use only bc=Ge, bc=com time-
out may occur due to slow system
response. Use the exact cuto avoid

timeout.
N J

See Optimizing LDAP Directory Search (on
page 22)

User Base OU=Sal es, QU=User s, QU=En- Defines the starting point for the LDAP group
terprise, DC=conpany, DC=com | user search in the active directory tree.

(L ™\
Note:
If you use only bc=Ge, bc=com time-
out may occur due to slow system
response. Use the exact cuto avoid

timeout.
N J

See Optimizing LDAP Directory Search (on
page 22)

User Filter user Pri nci pal Name={ 0} Allows the LDAP user (active directory user)
to login into Configuration Hub with their

email address.

User Filter cn={ 0} Allows the LDAP user (active directory user)
to login with their display name. This is field
is populated by default.

User Filter sAMAccount Name={ 0} Allows the LDAP user (active directory user)
to login with their account name (Windows
login name). This is field is populated by de-
fault.
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Search Criteria Example Value Description

Group Filter menber ={ 0} Retrieves the menber o attribute values for
the specific user. This is field is populated by
default.

Max Filter 10 Defines the maximum depth for searching
the LDAP groups. The default value is 10.

For very large systems, set the value to 2 as

it may impact system performance.

Optimizing LDAP Directory Search

This topic describes how to efficiently perform searches for objects (such as users and user groups) in an
Active Directory service.

In Active Directory, resources are organized into structures called classes.

Classes are logical groupings of objects such as:

* User accounts
* User groups

» Computers

* Domains

« Organizational units

Some objects, referred to as 'containers’, can hold other objects. For example, an organizational unit is a
container object. Therefore, the organization of objects in Active Directory follows a hierarchical structure.

The following illustration depicts a hierarchical arrangement of a tree with three domains, each having its
own set of organizational units (OUs) for users and groups.
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— ou=HR cn=userl
— ou=IT cn=user2
— ou=departmentl
cn=user3
— sitel.georg.com |
] ou=DEV T cn=user4
-+ ou=department2 |- cn=userl0
georg.com —
- site2.georg.com [~ ou=department3
— site3.georg.com |—{ ou=department4

User Search Base and Group Search Base

The User Search Base and Group Search Base set the scope for searching the respective objects in Active
Directory's hierarchical structure. Therefore, it is recommended to select values in such a way that they
are specific enough to reduce the scope of the search only to the intended area in the tree structure, while
ensuring no intended User or Group is missed within the search scope.

Maximum Search Depth

The Max Fi | ter parameter determines the maximum depth or level applied when searching the Active
Directory hierarchy. This value specifies the number of recursive levels at which the search for contained
Group objects is performed for each Group object encountered while searching in Active Directory's
hierarchy structure.

Example: Consider a containment hierarchy consisting of a nested structure of user groups (UG1 to UG4)
in a hierarchical format, wherein:

* UG1 contains UG2
* UG2 contains UG3
» UG3 contains UG4

L Ux
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L U

L U4

If the logged-in user has direct group membership in UG4, and:

if Max Filter is setto 4 then, the search for the user’s group membership returns all
groups in the hierarchy, including UG1, UG2, UG3, and UG4.

if Max Filter is setto 3 (or less) then, the user’s group membership returns only UG2, UGS,
and UG4. It does not go beyond the third level in the hierar-
chy.

if vax Filter issetto 10 then, the search returns all groups (UG1 to UG4) as specified

but it involves unnecessary recursive calls (10 in total, out of

which 6 are unnecessary). This can impact performance.

In summary:

1. The default value for Max Filter is 10.

2. It is recommended to choose a value aligned with the maximum nested level in your Active
Directory's Group hierarchy to avoid unnecessary recursive calls and performance issues.

3. Typically, customers choose values like '1' or '2' based on common nested level/depth of User
Groups in most scenarios. However, the choice ultimately depends on your specific requirements

-
0 Tip:
You can use third-party tools like Softerra LDAP Browser or AD Explorer to check connectivity to

the LDAP server. You can also explore the organizational hierarchy and locate specific Users and
Groups within the directory.

N

~

SAML
Enable SAML
This topic describes how to configure SAML identity providers for Proficy Authentication.

You should enable SAML prior to adding SAML IDP accounts (on page 46) in Proficy Authentication.

To enable SAML, you will need to download the Proficy Authentication service provider's metadata file.


https://www.ldapadministrator.com/softerra-ldap-browser.htm
https://learn.microsoft.com/en-us/sysinternals/downloads/adexplorer
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1. Visit https: //enter FQDN of the machine where Proficy Authentication is installed/ uaa/san /netadata to
download the sani - sp. xni file.

2. To configure any SAML identity provider, gather information from the downloaded sani - sp. xni file.

3. Generate a metadata XML file from the configured identity providers, and use the file to add a
SAML IDP account (on page 46) in Proficy Authentication.

Refer to the following examples on how to set up SAML identity providers for Proficy Authentication:

« Configure Okta as SAML IDP (on page 26)
- Configure Azure AD as SAML IDP (on page 32)

SAML Configuration Flow

The following diagram is a visual representation of the key components involved in the SAML
configuration flow.

SAML CONFIGURATION FLOW

Administrator User IDP IT Expert User

Confighub Admin/IFix Admin For Example, Azure AD IT

Provide info to SAML IDP IT Expert.
Identifier (Entity ID) : https://host/uaa/sam|/metadata
Reply URL (Assertion Consumer Service):
https://host/uaa/saml/SS50/alias/ophubSamiSp
[OR]

Service Provider metadata xml: saml-sp.xml

v

Create Application in SAML IDP

Configure SAML IDP in ConfigHub
Security Plugin

IDP Metadata xml

N

In the SAML configuration flow, Proficy Authentication Service acts as a SAML Identity Provider (IDP).
You must configure Proficy Authentication Service as an IDP by providing it with the necessary SAML

metadata and settings.
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The following figure illustrates how the data flows and interacts to ensure secure access to resources.

Proficy Authentication Service

RESOURCE SERVER
. IFIX Services
. Plant Apps
6)/> . Historian
w |
user name / password Client Appllcatlon M’FA ~ Mlc.rosol."t .
“iFIX Client App Active Directory service
ConflgHub/opsHub

AUTHORIZATION SERVER \
Proficy Authentication Service

[Oauth2, OpenlD Connect |

. MFA SAML 2.0 IDP Server
. LDAP * OKTA
. SAML Service Provider ® Azure AD

* Keycloak

# ForgeRock
etc...

1. Users provide their credentials, which includes a user name and password.
2. When users attempt to access a protected application, they are redirected to the Proficy
Authentication Service for authentication.

Proficy Authentication Service generates a SAML authentication request and sends it to the user's
browser. This request is sent to the configured IdP endpoint.

3. If users are successfully authenticated, they gain access without the need to log in separately.

Configure Okta as SAML IDP

This topic describes SAML configuration with Okta.

1. Create an account in Okta.

a. Visit https://developer.okta.com/.

b. Sign up for an Okta account using your email address.
2. Log in to your newly created Okta account.
3. Navigate to Applications > Applications.


https://developer.okta.com/
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okta

Dashboard e

Directory w

Customizations g

Applications -
Applications

Self Service

Security hd

4. Select Create App Integration.

Developer Edition provides a limited number of apps.

Deactivate unused apv check out our plans page. Contact us to find a plan that is right for your organization.

Create App Integration Browse App Catalog Assign Users to App More -

Search
STATUS @ Okta Admin Console
ACTIVE 0
INACTIVE 0 @ Okta Browser Plugin

Okta Dashboard

The Create a new app Integration screen appears.
5. Select SAML 2.0, then select Next.
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Create a new app integration

Sign-in method

Learn More [

OIDC - OpenlD Connect

Token-based OAuth 2.0 authentication for Single Sign-On (S50) through API
endpoints. Recommended if you intend to build a custom app integration with
the Okta Sign-In Widget.

SAML 2.0

XML-based open standard for S30. Use if the |dentity Provider for your

application only supports SAML.

SWA - Secure Web Authentication
Okta-specific S50 method. Use if your application doesn't support QIDC or
SAML.

AP Services
Interact with Okta APls using the scoped OAuth 2.0 access tokens for

machine-to-machine authentication.

Cancel MNext

The Create SAML Integration screen appears.
6. Under General Settings, provide a name and logo for your application, then select Next.

o General Settings

1 General Settings

App name

App logo (optional)

App visibility

Cancel

Configure SAMI

Multiverse Paradigm

Do not display application icon to users

7. Under Configure SAML, fill out these details:
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Single sign on
URL

Use the dowloaded Proficy Authentication metadata file (on page 24)
sani -sp. xm to get the URL for this field. It should look something like this:

T —— T 04T

<md:AssertionConsumerService
Location="https://ghldz593e.logon.ds.ge.comfuaa/saml/SS0/alias/ophubSamiSp"
Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST" isDefault="true"
index="0"/>

<md:AssertionConsumerService
Location="https://ghldz593e.logon.ds.ge.com/uaa/oauthftoken/alias/ophubSamiSp"
Binding="urn:oasis:names:tc:SAML:2.0:bindings:URI" index="1"/>

Audience URI (SP
Entity ID)

Refer to san - sp. xnl to get the logout URL. It should look something like this:

<?xml version="1.0" encoding="UTF-8"7>
- <md:EntityDescriptor entityID="https:f/ghldz593e.logon.ds.ge.com/fuaa/saml/metadata”
ID="https___ ghldz593e.logon.ds.ge.com_uaa_saml_metadata”
xmins:md="urn:oasis:names:tc:SAML:2.0:metadata">
- <ds:Signature xmins:ds="http:/ /www.w3.0rg/2000/09/xmldsig#">

ST

Enable Single Lo-
gout

a. Select Show Advanced Settings.

b. Select the check box for Allow application to initiate Single Logout.

c. Enter Single Logout URL. Refer to sani - sp. xm to get the logout URL. It
should look something like this:

</md:KeyDescriptor>
<md:SingleLogoutService
Location="https:/ /ghldz593e.logon.ds.ge.com fuaa/saml/SingleLogout/alias/ophubSamiSp"
Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-POST"/>
<md:SingleLogoutService
Location="https:/ /ghldz593e.logon.ds.ge.com fuaa/saml/SingleLogout/alias/ophubSamiSp"
Binding="urn:oasis:names:tc:SAML:2.0:bindings:HTTP-Redirect"/>
L.

wradsBlammalNEnrmm st armsnmeimsm s amcbe s ©ARME 21 1 s

Attribute State-

ments (optional)

Add user attribute statements such as email, first name, and last name as
shown here:

Attribute Statements (optional)

Marma M format Vilea
&ma Unaspecified " user.email v
st name Undgacitiiad udar HrstName v
ust MAMe Unspacified " usarlasthame v
Add Anather

Group Attribute
Statements (op-
tional)

Add group attribute statements such as groupA and groupB as shown here:
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Group Attribute Statements (optisnal)

Nama MName format Filter
groupé, Unspecified w Contains - manager
EroupB Unspecified * Contains =  operator

fdd Another

-

N

Note:

The setting option mentioned in this topic is the minimum requirement for setting up
the SAML identity provider. Refer to the Okta documentation for information on using

additional settings.

8. Select Next.
9. Provide your feedback and select Finish.

Previous

3  Help Okta Support understand how you configured this application
Are you a customer or partner? I'm an Okta customer adding an internal app

ﬂ I'm a softwara vendor. I'd like to integrate my app with
Okta

Onee you have a working SAML integration, submit it for Submit your app for review
Qlkta review to publish in the OIN.

Your application is created.
10. Under Sign On, select Identity Provider metadata.



https://help.okta.com/en-us/Content/index.htm
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Multiverse Paradigm

| Active -

Once you have a working SAML integration, submit it for Okta review to publish in the OAN.

v

General Sign On Import Assignments

| - | View Logs Meonitor Imports

Settings Edit

Sign on methods

The sign-on method determines how a user signs into and manages their credentials for an
application. Some sign-on methods require additional configuration in the 3™ party application.

Application username is determined by the user profile mapping. Configure profile mapping

SAML 2.0

Default Relay State

SAML 2.0 is not configured until you complete the setup instructions.

View Setup Instructions

Identity Provider metadata is available if this application supports dynamic configuration.

Credentials Deatails

The metadata opens in a new tab.
11. Save the metadata as an .xml file.
Use the metadata xml file to configure a SAML identity provider (on page 46) in Proficy
Authentication.
12. Under Assignments, you can assign the app to groups and individual users.
If there are no users/groups, navigate to Directory > People to create and activate new users/

groups in Okta.
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Configure Azure AD as SAML IDP

This topic describes how to configure Azure AD (Active Directory) as a SAML identity provider.

To configure SAML as an authentication scheme for single sign-on, you must have the following:

Pre-requisite

Description

Create Your Azure
Account

If you don't already have an Azure account, you should create one to proceed with
the SAML configuration. Visit https://azure.microsoft.com/en-us/free/ to sign up
for a free account. Make sure your account has sufficient privileges to perform the

SAML configuration.

Set Up Your Enter-
prise Application

Do the following to set up an enterprise application in Azure with the necessary con-

figuration.

1. Log in to your Azure account.
2. Refer to the steps described in Microsoft Azure documentation on how to
create a new enterprise application. In the steps that follow, we shall refer to

an example enterprise application called bobt est san .

Associate Users
and Groups

For the SAML setup to work, you have to associate at least one user and one group
with the enterprise application. This is important for the authentication process.

1. Log in to your Azure account and navigate to the enterprise application you
created earlier (bobt est sani is our example application).

2. Select Users and groups > Add user/group.

3. Search and assign the user/group to the application.

In the steps that follow, we shall accomplish the following:

* Create a SAML App in Azure (performed by your skilled IT Azure Expert).
o Download the SAML Metadata file (on page 33)
o Upload the saml-sp.xml File to Azure AD (on page 33)

o Perform User and Group Attribute Mapping in Azure (on page 36)
- Configure Azure Metadata XML in Proficy Authentication. (performed by the Application

Administrator.)
o Create SAML Connection in Proficy Authentication (on page 39)
o Adding and Mapping UAA and SAML Groups (on page 42)
o Test SAML Authentication (on page 44)



https://azure.microsoft.com/en-us/free/
https://docs.microsoft.com/en-us/azure/active-directory/manage-apps/add-application-portal

Proficy Authentication | 1 - Proficy Authentication | 33

See also, Troubleshooting (on page 44).

1. Download the SAML Metadata file

a. Log in to Configuration Hub.
Use valid credentials, preferably the default cli ent I D.

b. Navigate to Proficy Authentication > Security > Identity Provider and download the UAA
sam -sp. xm metadata file.

HAAGATION BN Socurity Procy Suthenticatinn DETAILS
L+ W Proficy Authenticat Mantity Prosidir
Q s
Q c+ 8
Idenkity Providers 1 t v ADMINGTRATOR CRIDENTWALS =y

First Selection T )
Aushenticat

Second Selection Third Selection we  LIAK META DATA D

The metadata file is downloaded to your browser's Download section.
2. Upload the saml-sp.xml File to Azure AD
a. Visit https://portal.azure.com and login with your valid credentials.

b. After logging in, select Azure Active Directory.

g N
0 Tip:
You can find it under recent services, or by using the search option.
N /
Under recent ser- m 2 Search resources, services, and docs (G+/)
ViCeS: Azure services
+ 3 — @] () « ®
Create a Azure Active Storage Virtual Resource Subscriptions Quickstart App Services SQL databases
Directory accounts machines groups Center
Resources
Run a search using T
the Search bar: Azure servict All Services (99+) Marketplace (9) Documentation (99+) Azure Active Directory (8) Resources (0)
Resource Groups (0)
e B Azure Active Directory @ Azure Database for MySQL servers



https://portal.azure.com
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c. Under Azure Active Directory, locate the enterprise application to which you want to
establish a SAML connection.

0 General Electric International, Inc. | Overview

| Add v ) Monage tenants (B Wnatsnew | [ Previewfeotures | /9 Got feedback?

@ Overview

I Preview festures © Aaure Active Directory is becoming Microsoft Entra 10, Leam more &2
K Diagnose and solve problems Overview  Monitoring  Properties  Recommendations  Tutorials
Manage Search your tenant
& users

Basic information
& Groups
B Baermal Identities Name General Electric Intermnational, Inc. Users.
& Roles and sdministrators .

Tenant ID B Groups
& Administrative units

Primary domain Applications
b Delegated admin

License Azure AD Premium P2 Devices

You can locate the application from recent searches, or running a search.
- J

Searching applica- | EEESEEN =T

A Enterprise applications | All applications

tion:

o Acd fiters

Ty Object B Application 1B Homepage URL Created on %y Cerificate Bxpiry St Identifies URI (Er

|f needed' request SRR WP O Search resources, services, and docs (G+/)

your IT Azure Ex- Eéi Ent.e.rp.ri-s-e applica.tic;n.s |.AI|.app-|ic.ation.5.

pert team to create —
O Overdew

a new application X

& and solve problems e list of applications that are maintained by your organization are in spplicat

Manage > bobtestsaml ] Appiication type == Enterprise Applications X Appiication 1D starswith X i Add fiters
from here: Fye——

B Appication prosy Narme T, ObjectiD Application 10 Homepage URL Created on Ty Certficate Expiry 5L

B Usersettings B sovreseom

B App laun

d. Open the enterprise application and select Set up single sign on.
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Home > General Electric International, Inc. | Enterprise applications > Enterprise applications | All applications >

bobtestsaml | Overview

Enterprise Application

i Ovenview Properties

(D Deployment Plan Name @

# Diagnose and solve problems l bobtestsaml h]
cation ID G

Manage Application ID &)

iI! Properties

: ObjectID @

& Owners

&, Roles and administrators )
Getting Started
& Users and groups

3 Single sign-on

& Provisioning | a 1. Assign users and groups —3 2. Setup single sign on

B Application proxy Provide specific users and groups access Enable wsers to sign into their application
to the applications using their Azure AD credentials

C  Self-service Assign users and groups Get started

e. Select Upload metadata file and upload the sani - sp. xni file we downloaded in the earlier
step.

Home > General Electric International, Inc. | Enterprise applications > Enterprise applications | All applications > bobtestsaml|

bobtestsaml | SAML-based Sign-on

Enterprise Application

i T Upload metadatafile [ Change single sign-onmode #= Test this application | & Got feedback?

B Overview

Upload metadata file.
Values for the fields below are provided by bobtestsaml. You may either enter those values manually, or upload a pre-

[ Deployment Plan

# Diagnose and solve problems configured SAML metadata file if provided by bobtestsaml.
a
Manage [ Select a file |-
- ’
B Ehoeeils | _aca |
Cancel

& Owners

R — 7 Edit
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f. After the file is uploaded successfully, Azure displays the information from the sani - sp. xni
file.

Microsoft Azure A Seacch resouroes, senices, and docs (G+/)
Home nal, Inc. | E ons > Enterprise applications | Al applications > bobtestsaml
bobtestsaml | SAML-based Sign-on X
T Upload metadata fle 7 Change single sign-on mode  [2 Test this appication &7 Got feedback?
B Ovenview - J
[ Oepscyment Pran Setup S
K Diagnose and sobve probilerns
An 550 snplementation Based on federation prOICCOIS IMproves secunty, 1 Ty, and end USeT experenoes and i§ easier 1o
Manage implernent. Choose SAML single sign-on whenever possible for exsting apy s that do mat use OpeniD Connect of DALt Learm
1 Propesties
8 owes ] prere— e
& Foles and sdmintratocs
Icenvifier (Entity 10} fuan/samimetad
& Users and groups
Riaphy URL (Assartion Consumrsar Sence LIRL) fuanjsami/SSO/al
D singhe sign-on
' Provisioning
fusa/sami/Singie
© Sef-service
Atributes & Clsims 2 Eit
Security
Grenname user Grennamse
surname usetsumame
8 emailacidress user mail
& Permissions
name user Lserprincipainame
®  Token ercryption Uniicgue Used | deritifier Uit LA PN PAInATE
Group user groups
Activity
D sign-inbogs
S B R 4

3. Perform User and Group Attribute Mapping in Azure

a. In the enterprise application, under User Attributes & Claims section, select Edit.

Home > Enterprise applications | All applications > bobtestsaml
bobtestsaml | SAML-based Sign-on
Enterprise Application
« T Upload metadatafile ) Change single sign-on mode Test this application & Got feedback?

i Overview - a

Basic SAML Configuration .
Deployment Plan & Edit
K Diagnose and solve problems Identifier (Entity D)

Reply URL (Assertion Consumer Service URL)
Manage
1I! Properties Sign onURL

Relay State (Optional)
&2 Owners Logout Url (Optional)
4. Roles and administrators
&8 Users and groups e

X X Attributes & Claims .

2 Ssingle sign-on & Edit
@ Provisioning givenname user.givenname

surname user.surname

tion proxy emailaddress user.mail
X name user.userprincipalname

C  Self-service . ) . Lo

Unique User Identifier user.userprincipalname

ity attributes Group user.groups
-

b. Select Add new claim.
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=S Microsoft Azure P Search resources, services, and docs (G+/) i) @ B O & 2

Home > | Enterprise applications > Enterprise applications | All applications > bobtestsaml | SAML-based Sign-on > SAML-based Sign-on >

Attributes & Claims

—+ Add new claim |+ Add a group claim == Columns &2 Got feedback?

Required claim
Claim name Type  Value
Unique User Identifier (Name ID) SAML  user.userprincipalname [nameid-formatemai... **
« »
Additional claims
Claim name Type Value
http://schemas.microsoft.com/ws/2008/06/identity/claims/groups SAML user.groups [SecurityGroup] LO0
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress  SAML user.mail
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/givenname SAML user.givenname
http://schemas.xmlsoap.org/ws/2005/05/identity/claims/name SAML user.userprincipalname

http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname SAML user.surname

v Advanced settings

c. Enter claim details, and save the information.

= Microsoft Azure L Search resources, services, and docs (G+/)

> Enterprise applications | All applications > bobtestsaml| | SAML-based Sign-on > SAML-based Sign-on > Attributes & Claims >

Manage claim

Save | X Discard char ;3\7 Got feedback?

Name * [ givenName

Namespace { http://schemas.xmlsoap.org/ws/2005/05/identity/claims

v Choose name format

Source * @ Attribute O Transformation O Directory schema extension (Preview)
Source attribute * I user.givenname

~  Claim conditions

v Advanced SAML claims options

( Note: )

Make a note of the Namespace value. This value will be used later while setting up

SAML Connection in Proficy Authentication.
- J

d. To set up group claims, select Add a group claim.
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Ty

Home > General Electri

tematicnal, In. | Enterprise applications » Enterprise applications | All applications > bobtestsaml | SAN Group Claim:
Attributes & Claims Managt the group e used by Az AD to popaliste SAML tokers isurd 10 your app
. Whseh Gionipsl MO with the ubdd Ihandd B Feturnid  the dim?
- dd new et I:l == Colmmns | Gotleedbuck? O ore
) An groups
Required claim (®) Security groups
Clair name Type Value ) Directony roles
_ () Groups assigned ko the application
Unigue User kgentifier (Mame D) SAML user usaprincipalname [ *+*

. Source attribute *
Additional claims

| saMaccountiame
Claim name Type Value

As This source attribute cnly worls for Groups symcheonized from an on-premises Acthe Ding
L os0fLoo identity/claims/groups  SAML user.groups [SecuntyGro. *** wsing AAD Connect Sync 1.2.T0W0 or above. Leamn Mare
hittp/fechem. L s 5/ tyfclaimsfemailadd... SAML user.mad

Emit group name for cloud-only groups

Frittpr fechemas amilsoap.crg, s 2005/05 identitycliims/givennime  SAML USEr GIVENNAME

it fschemas smisoap.cogws 200%/05/id v Advanced options

ity fehimns s SAML user userpringipalname

It orgws/2005,/05/ entity chaims/surname  SAML e SLETATE

You can choose to provide Advanced options for the group claim as shown in the following
screen shot.

For example, string type is selected as Mes because we want to cast our groups to start with
MES, You can select as per your choice.

Home 3 General Electric Intemational, Inc. | Enterprise applications > Enterprise applications | All applications > bobtestsami | SAN Em]lp Claims
ttributes & Claims Msnge the group claim

Source
SAMALC O lame R
4 Add new claim == Cohmns 7 Got feedback?
& This source sttribute only works for groups symehronized
Directory using AAD: Connect Symc 1.270.0 or above. Lea
Required claim
Emit growp ramne for cloud-cnly groups (&
Claim name Type Value
Unique User Identifier (Name 10} TAML user userprincipalname [.. ~ hdvanced options
Additional claims B fer groups.
Claker rarme Type Value Aibute 10 match *
W Leom/ve 200806 Jelsime/groups  SAML e, groups [SecurityGre... *** | saMacoountivame:

it schemas arilsoapucag s 200505 kentity claims femailad..  SAML wsermad Match with *

hittprfschemas xmilsoap. o s 200505 identity/claims fgivenname  SAML user.grenname Prefix

it fseheras armilssap. e /200505 identityfelsires fname SAML e seprindpiiname Sarng *

Ity schemas amilsoap. o s/ 2005, 05 dentityclaimasurmame  SAML SEr.Sumame [meg |

[ Customize the name o the group claim

w Advanced settings

After updating the group claim, Attribute & Claims screen should look like as shown in the
following screen shot. The highlighted claim name needs to be same while creating SAML
Connection in Proficy Authentication.
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[ oo BT

Home » G Electric internaticnal, inc. | Ent applications > Enterprise applications | All applications > bobtestsaml | SAML-based Sign-on
Attributes & Claims
+ Add new claim == Cowmns | A7 Got feedback?
Required claim
Claim name Type Value
Unique User ldentifier (Name 10} SAML user.userprincipalname [... ***
Additional claims
Claim name Type Value
httpe/fschemas.microsoft.com/ws/2008/06dentity/claims/groups  SAML user.groups [SecurityGra,., **°
http/fschemasxmiscap.org,ws/ 2005/ U3 identity/claims/emailadd..  SAML user.mail

e. Under the SAML Signing Certificate section, download the Federation Metadata XML file.
We shall upload this file later when creating a SAML Connection from Proficy

Authentication.
name user.userprincipalname
Deployment Plan
m ey ' Umigue User Identifier user.userprincipalname
A Diagnose and solve problems Group USEr.groups
Manage o
ML Certific
Il Properties SAML Certificates
.
& Owners Token signing certificate 2 it
) Status Active B
& Roles and administrators Thumbgprint E1BS8ARIT2T
& Users and groups Expiration 5/11/2026, £:23:05 PM
: Metification Email Bge.com

D single sign-on App Federation Metadata Url httpsy/login.micresoftonline.com/15ccbbd1-d335... [
D Provisioning Certificate (Basefd) D

Certificate (Raw)
Federation Metadata XML

& Self-service
Verification certificates (optional) £ Edit

Required N

Active 0
0

Security
Expired

4. Create SAML Connection in Proficy Authentication
a. Log in to Configuration Hub as an administrator.

b. Go to Proficy Authentication > Security > Identity Provider.

c. Select + then select SAML.
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NAVIGATION B < cority-Proficy Authentication
\ S Proficy Authenticatior
T Security
Q. Search P
@ White Labeling i
Identity Providers 1
> W Administration

d. In the SAML Identity Provider pop-up screen, enter details.

Field Name Description

Upload XML File Upload the Federation XML downloaded from Azure. Refer to
this step (on page 39).

Name Name of the SAML application. You can provide any name.

Attribute Name Enter the Group Name mapping. Refer to this screen shot (on
page 38).

Name ID From drop down, select f or mat : unspeci fi ed.

Enable SAML Link Select the check box.
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| . B

SAML Identity Provider o) i il o
Attributes & Claims
NOTE : Allfelds are mancatory F Atten o | et
(®) Upload xMLFile () Provice Fie Location feaiecom
cumane e e
Unique User entifr (Name 10) ML userserpincipiiname .. ***
Upload XML File Addtoral dims
Climnime Tipe Valoe
| ML
<mmlversion="1.0" encoding="utf-8'2><EntityDescriptor ID=" c82426a5-0106-40b8-  * - -
a0f8-cab3a1288529" entitylD="https://stswindows net/b072267b-2965-4512-8905-
NChOTNeQhO0 M salae=t i £aC AML 1 Nomatadabals «Cianak i
Name*
Azure AD SAML
Attribute Name*
http;//schemas.microsoft.com/ws/2008/0/identity/claims/groups
Name D
urm:oasisnames:te:SAML: 1. 1:nameid-format:unspecified X
Enable SAMLLink

Cancel Save

After successful SAML connection, the application screen should look something like this:

NAVIGATION X Security-Proficy Authentication DETAILS 4

ProficyA. Identity Provider ~ Groups ~ Users . "
iel Value

Security v GENERAL [
Q, Search + &

White La.. Name Azure AD SAML
Identity Providers Type Action MetaData <?xml version="1.0" encoding="utt-8"?><EntityDescriptor ID="_c82426...
Azure AD SAML saml o Group Attribute http://schemas.microsott.com/ws/2008/06/identity/claims/groups
NewLdap \dap namelD urn:oasis:names:tc:SAML:1.1:nameid-tormatunspecified
OKTA-SAML saml Origin Key Azure AD SAML
uaa uaa v OTHER SAML PROPERTIES
UAA LDAP Idap link Text Login With Azure AD SAML

“V  USERATTRIBUTE MAPPING

First Name http://schemas xmlsoap.org/ws/2005/05/identity/claims/givenname
Last Name http://schemas xmisoap.org/ws/2005/05/identity/claims/surname
Email http://schemas.xmlsoap.org/ws/2005/05/identity/claims/emailaddress
Phone contact

Email Verified emailVerified

! Important:
You must perform User Attribute Mapping, which involves taking values from the
Azure Attributes & Claims page and linking them to the Details section of the
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established SAML Connection in Proficy Authentication. Refer to the example

screen shots below.

Attributes & Claims DETAILS »

~  GENERAL =z
Name Azure AD SAML
MetaData <2xml version="1.0" encoding="utt-8 2><EntityDescriptor ID="_c82426.
i | Group Attribute http://schemas.microsoft.com/ws/2008/06/identity/claims/groups
namelD urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified
Origin Key Azure AD SAML

v OTHER SAML PROPERTIES
link Text Login With Azure AD SAML

N USERATTRIBUTE MAPPING

First Name http://schemas xmlsoap.org/ws/2005/05/identity/claims/givenname
Last Name http://schemas xmlsoap.org/ws/2005/05/identity/claims/surname
Email http//schemas xmisoap.org/ws/2005/05/identity/claims/emailaddress
Phone contact

Email Verited smaillferifiad

5. Adding and Mapping UAA and SAML Groups
a. Go to Proficy Authentication > Security > Groups.
b. Double-click and open the group you want to map to SAML.
c. Select the Mapping tab.
d. Map SAML groups: From the Identity Provider drop down list, select the SAML record.

e. To create SAML groups, enter the valid SAML group name in the Add SAML Group field and

select the plus icon.
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Group

iqp.developer

Member(Users)  Mapping

Member(Groups)

PR L TTTI SR i p.developer-Proficy Authentication

Identity Provider

Azure AD SAML

Add SAML Group

MES_Operator

+

Groups

Mapped Groups

f. Select the check box for the groups you want to map to the Proficy Authentication group

selected in step 5(b).

g. Select 9 to move the selected items from Groups to Mapped Groups.

-1
NAVIGATION
M B Proficy Authe.
@ Security
@ White Labe...

> Administration

If the mapped SAML groups are valid, then all their users become a member of the Proficy

Security-Proficy Aut... Bl iqp.developer-Proficy Authentication

Group

iqp.developer

Member(Users) Mapping Member{Groups

Identity Provider

Azure AD SAML

Add SAML Group

Groups

MES_Admin_User

Available group for mapping

Authentication group selected in step 5(b).

+

Mapped Groups

MES_Operator

Successfully mapped groups

DETAILS

DE
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6. Test SAML Authentication
a. Visit Operations Hub login page.

b. Select Sign In With Azure.

GE Digital

Welcome!

or sign in with:

Login With Azure AD SAML

Troubleshooting SAML-Related Issues
Addressing Login Issues With Azure:

In Azure portal, you can access the logs to verify successful logins. This will help establish a baseline for
successful authentication. Whenever login access is denied, closely review the login attempts in the logs.

3 bobtestsaml | Sign-in logs % - X
Enterprise Application
& | Download v £33 Export Data Settings # Troubleshoot () Refresh == Columns &4 Got feedback?
& Users and groups -
3 single sign-on @ Want to switch back to the default sign-ins experience? Click here to leave the preview. —
@ Provisioning
Show dates as : Local Application contains f46 7 +p Add filters
Applicat
e sef 2 User sign-ins (interactive) ~ User sign-ins (non-interactive) Service principal sign-ins Managed identity sign-ins
elf-service R T S————
tom security attributes Date o RequestID ™ User 7y Application Ty Status 1P address T Location
Security 9/5/2023, 10:01:30 PM  7aa . M z(.. bobtestsaml Success 2 7 Fa Connect
Access 9/5/2023, 9:54:36 PM  Ocb . M z (... bobtestsaml Failure 2 '8 Fa Connect
8, Permissions 9/5/2023, 6:16:56 PM 633 .M z(.. bobtestsaml Success 2 8 Fa Connect
® Token encryption 9/5/2023, 6:1655 PM  a7a M z(.. bobtestsaml Success 3 8 Fa Connect
9/5/2023, 6:16:54 PM  6ec . M z(.. bobtestsaml Success 2 8 Fa Connect
Activity
9/5/2023, 6:16:54 PM  be€ .M z(.. bobtestsaml Failure 2 8 Fa Connect
3 Sign-in logs
- 9/5/2023, 4:45:12 PM  3e2 .M z (... bobtestsaml Failure 2 3 Fa Connect
@il Usage & insights
9/5/2023,4:45:11 PM  1d7 . M

z (.. bobtestsaml Failure 2 3 Fa Connect
& Audit loas hd — 5

Addressing Login Issues Without Azure:
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You can use the SAML-tracer extension for Chrome to diagnose and resolve SAML-related problems in
Operations Hub. Follow these steps:

1. Install SAML-tracer: Add the SAML-tracer extension to your Chrome browser.
2. Access SAML-tracer: Open SAML-tracer from your browser extensions.
3. Reproduce the Issue: Log in to Operations Hub as you normally would to reproduce the SSO login
issue.
4. Inspect SAML Messages: In SAML-tracer, look for PoST messages.
a. Select the specific POST message related to the SSO login attempt.
b. Next select the Summary tab for detailed information about the SAML attributes exchanged.
c. Review the SAML attribute names and values exchanged during the SSO attempt, and
compare them against the expected values.
d. If you notice that the SAML group attribute names are incorrect (refer to screen shot), this
could be the cause of the login issue.

A SAML-tracer

L= Autoscion | Fer resources | 0 Colorze [ SSR RS
POST GO OB oMonlne CoMBSANS5-6842-4 9622

~ COMRUAASAMVS SOV sl vophub Samitp

‘mnm

17T
]

e. Replace the incorrect attribute names with the correct ones to fix the login issue.

Retrieving Azure Login Screen:

In case you encounter a situation where the Azure login screen does not appear, then do the following to
address this issue:

« Check your SAML Azure configuration. Verify the group attribute name and the corresponding
group name. Any mismatch in attribute names can lead to access issues.
« Clear your browser cache and login again.


https://chrome.google.com/webstore/detail/saml-tracer/mpdajninpobndbfcldcmbpnnbhibjmch?hl=en
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Add SAML Identity Provider

This topic describes how to add multiple SAML accounts in Proficy Authentication.

Enable a SAML identity provider (on page 24). For example, Okta or Azure AD or any other IDP.

You can add multiple SAML connections.

1. Log in to Configuration Hub as an administrator.

2. Go to Proficy Authentication > Security > Identity Provider.

3. Select _I_ then select SAML.

Security-Proficy Authentication

Identity Provider ) Groups

Q. Search

Identity Providers T
Okta Login Station

Uda

The SAML Identity Provider screen appears.

Lsers

saml

uaa

4. Enter the following details:

LDAP

s

Note:
The XML file contains the metadata to interact with SAML enabled identity providers
(Azure, ADFS, or Okta). Refer to Configure Okta as SAML IDP (on page 26).

Field

Description

Upload XML File

Choose this option if you want to upload an
XML document.

Select Upload XML File to browse and locate
the XML document from your local system.
The uploaded data appears in a text box, and is

read-only.

Provide File Location

Choose this option if you want to provide an ex-
ternal URL to the XML document.
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Field Description

Enter the URL in the text field, and select Load.
The data from the URL appears in a text box,
and is read-only.

Name Name of the SAML identity provider. You can
provide any name. For example, okt a_123 oOfr de-

nmo_mach_azure.

Attribute Name The attribute that contains the group member-
ship information about a user in a SAML asser-
tion.

Name ID SAML Name identifier and associated fields

that you want to use in a link test.

Enable SAML Link Select the check box.

SAML Identity Provider

HOTE : All fields are mandatory

https:/dev- 38020232 okta.com/app/exk 2uugkcSPLEdfaaSd T ss0/saml/meta Load

< #oml version="1.0" encoding="UTF-&"#> <mdEntityDescripbor

entitylD="httpy www.oktacomyedk2uughc SPUbI faa5d7T” —
EETY PERETY IR r Sr S LR S R T [y Wy FEEET FR PY PR TR R a1y ol afa ' g FEELEY R
1=
kta_123
ikt & Mam
ema
Wil
umzoasisnames:bc-SAML: 1. 1nameid-formatemail Address W o=
.« Enable SAML Link

5. Select Save.

The SAML identity provider is created.
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Modify SAML Identity Provider

This topic describes how to modify the existing details for a SAML account.

Add SAML Identity Provider (on page 46)

1. Log in to Configuration Hub as an administrator.
2. Go to Proficy Authentication > Security > Identity Provider.
The existing list of identity providers appear.
3. Select the SAML identity provider you want to modify.
The existing information for the identity provider appears on the DETAILS panel.

4. Select EJH to display the details in a pop-up screen.

DETAILS x

Okta Login Station
Q, Search

>  GENERAL @

» OTHER SAML PROPERTIES

The SAML Identity Provider screen appears.

5. You can modify the existing information and save the changes.
6. You can also modify items under OTHER SAML PROPERTIES section. Enter a new value to replace

the existing value.
Enable Multi-Factor Authentication
This topic describes how to enable multi-factor authentication for users.
Install the Google Authenticator app on your mobile device.
Only administrators can enable multi-factor authentication (MFA) for users.

Note:

Enabling MFA also enables two-factor authentication for UAA and LDAP users as both the identity

providers have a common login entry point.



https://play.google.com/store/apps/details?id=com.google.android.apps.authenticator2
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1. Log in to Configuration Hub as an administrator.
2. Go to Proficy Authentication > Security > Identity Provider.
The existing list of identity providers appear.
3. Select the uaa record for which you want to enable the multi-factor authentication.
The option to enable MFA appears on the DETAILS panel under the MFA section.
4. Enable the toggle switch for MFA.
By default, MFA is disabled.

'  ADMINISTRATOR CREDENTIALS E’i‘

Client ID admin
v GENERAL
URL https://deskto...
~ MFA
Disabled -@
Authenticator Googl.. =~ v MFA
Enabled -
Authenticator Goopl. =

The multi-factor authentication for uaa is enabled.
5. Select Authenticator.

Currently, Google authenticator is the only available authenticator.
6. Restart the GE Proficy Authentication Tontat Wb Server Service.
7. Activate multi-factor authentication for user logins.

You need to perform the following steps only for the first time for every user login.

a. Log in to Configuration Hub with UAA user credentials.
The MFA setup screen appears with a barcode.
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Setup Multitactor Authentication

1. Install Google Authenticator on your mobile device from the App Store
on your iPhone or Google Play on your Android.

2. Open Google Authenticator on your mobile device,

i

. Tap the "+" button.
4, Tap "Scan barcode”,

L

. Scan this barcode:

Can't scan barcode? See manual setup instructions.

=

b. Open the Google Authenticator app on your mobile device and scan the barcode.
The authentication app validates the user login and displays a 6-digit code. Barcode

scanning appears only for the first time validation for every user login.

c. On your browser, select Next on the MFA setup screen.
The code verification screen appears.

d. Enter the 6-digit code in the passcode field and select Verify
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| GE Digital

4

Enter your Google Authentication Code

Enter the 6-digit code displayed in Google Authenticator app:

Back

You are logged in successfully.

Multi-factor authentication is enabled for both UAA and LDAP users.

Delete Identity Provider

This topic describes how to delete identity providers.

Add SAML Identity Provider (on page 46)

1. Log in to Configuration Hub as an administrator.

2. Go to Proficy Authentication > Security > Identity Provider.
The existing list of identity providers appear.

3. Select the identity provider you want to delete.
Additional options appear under the ACTION column.

4. Select EEE then Delete.
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Security-Proficy Authentication DE
Identity Provider ) Groups  Users 0Ok
Q

Q. Search + {?‘}
Identity Providers 1 Type Action I -

Okta Login Station saml

Map Groups

uaa uaa .ﬁ

A message appears to confirm the delete action.

5. Select Delete.

The identity provider record is deleted from the Proficy Authentication database.

Manage Groups

Overview of Managing Groups in Proficy Authentication

Groups are a collection of users who share common roles or responsibilities. Administrators can assign

permissions and policies to entire groups, rather than individual users.

Groups make it easier to manage access control for multiple users with common requirements.
Depending on your group membership, you will have access to different areas of an application. You can

create groups and assign scopes that define the permission level granted to a client application.

« Scopes for Proficy Authentication Users/Groups (on page 53)
- Scopes for Operations Hub Users/Groups (on page 53)

« Scopes for iFIX Users/Groups (on page 54)

« Scopes for Historian Users/Groups (on page 55)

« Scopes for Plant Applications Users/Groups (on page 57)

Refer to these topics on how to work with groups within Proficy Authentication:

« Create Groups (on page 58)

» Modify Groups (on page 60)

» Map Groups (on page 61)

» Add/Remove Users in a Group (on page 64)
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» Add/Remove Sub-Groups in a Group (on page 65)

« Delete Group (on page 66)

Scopes for Proficy Authentication Users/Groups

This topic provides a list of scopes you can assign to users/groups for accessing Proficy Authentication.

Refer to the Cloud Foundry's documentation for a complete list of UAA scopes.

https://docs.cloudfoundry.org/concepts/architecture/uaa.html#uaa-scopes

Scopes for Operations Hub Users/Groups

This topic provides a list of scopes you can assign to users/groups for accessing Operations Hub.

To access both the designer and runtime features in Operations Hub, a user must possess, at a minimum,

the i gp. devel oper and i gp. user scopes.

Scope

Description

i gp. devel oper

This scope is assigned to developer users.

When a developer account is created, an associated application user ac-
count is automatically generated, sharing the same login credentials.
Users with this scope have the ability to access pages for application
creation, granting them access to both application design and runtime
functionality.

i gp. user

This scope is assigned to application users.

Users with this scope can only access those applications in Operations
Hub to which they have been granted access. These users do not have
the ability to access pages for application creation. Their access is sole-

ly restricted to the runtime functionality of the applications.

i gp. cl ouduser

This scope is assigned to users who want to use the REST API, mainly
the M2M Device RESTful APlIs.

i gp. noder ed

This scope is assigned to users who want to access the Dataflow Edi-

tor.

i gp. studi oAdm n

This scope is assigned to privileged users.


https://docs.cloudfoundry.org/concepts/architecture/uaa.html#uaa-scopes

Proficy Authentication | 1 - Proficy Authentication | 54

Scope

Description

Users with this scope can access the Administrator Console to config-
ure global settings for an Operations Hub instance, such as the settings
for email servers and the MQTT brokers for MQTT data interoperability.

Note:

This scope does NOT grant access to Operations Hub designer

or runtime.

i gp. t enant Adm n

This scope is assigned to privileged users.

Users with this scope gain administrative authority at the Tenant or Sys-
tem level (in our case, we have one tenant). They enjoy full administra-
tive access to the Operations Hub instance, with the exception of sce-
narios requiring membership in the i gp. st udi oAdni n group. Administra-
tors with this scope have the ability to unlock an application that may be

locked by another user.

Scopes for iFIX Users/Groups

This topic provides a list of scopes you can assign to users/groups for accessing iFIX.

Refer to the following table to assign access to specific areas/functionalities of iFIX:

Scope

Description

scada. fi x_shared_I FI X_PROFI CY_AUTH ADM N | Allows access to all iFIX application features. Any Profi-

cy Authentication user who is a member of this group

will have privileges similar to a native iFIX ADMIN user
(except the access to security areas). Proficy Authenti-
cation users who want to directly log in to iFIX can use

this group.

This group is not available by default when you upgrade
from iFIX 6.1 or 6.5. You must manually create this
group with all the iFIX application features as needed.

scada. fi x. shar ed. APPLI CATI ON_DESI GNER Allows a user to access Configuration Hub and provides

use of iFIX features such as iFIX connection, database,

and model management.
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Scope

Description

Important:

scada. fi x. shar ed. APPLI CATI ON_DESI GNER iS not
available by default when you upgrade from iFIX
6.1 or 6.5. You must manually create the group
with the required iFIX application features, or
update your existing groups to include the fol-
lowing iFIX application features (if you want
users in these groups to have access to and use
Configuration Hub).

+ Database Block Add-Delete
- Database Manager

« Database Reload

« Database Save

« Security Configuration

- System Configuration

scada. fi x. shar ed. OPERATORS

Allows run mode only access for a user in iFIX.

scada. fi x. shar ed. SUPERVI SORS

Allows access to WorkSpace run and configure mode,
as well as access to background task exit, iFIX system
shut down, and iFIX system user login.

scada. proficy. adm n:

Allows the Proficy Authentication user access to the
iFIX Projects panel and to the Deploy operations from
Configuration Hub. This group is for Proficy Authentica-
tion only; this group is not linked to any iFIX group and
has no permissions in iFIX.

Scopes for Historian Users/Groups

This topic provides a list of scopes you can assign to users/groups for accessing Historian.

Refer to the following table to assign access to specific areas/functionalities of Historian:
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Scope

Description

hi storian_visualization.adm n

Provides access to Trend Client and the Web Admin
console.

hi storian_vi sual i zati on. user

Allows access to Trend Client.

hi storian_rest_api.read

Provides read access to public REST API.

historian_rest_api.wite

Provides write access to public REST API.

hi storian_rest_api.admn

Provides read/write access to public REST API.

hi storian_enterprise. adnin

Provides read/write access to Configuration Hub
APls.

historian_enterprise. user

Allows access to Configuration Hub APIs.

i h_archive_adm ns

Provides the ability to create, modify, and remove

archives.

ih_audited_witers

Allows data writes and to produce a message each

time a data value is added or changed.

i h_col |l ector_adni ns

Allows the ability to add collector instances and

change their destination.

ih_readers

Provides access to the ability to read data and system
statistics. Also allowed access to Historian Adminis-
trator.

ih_security_adm ns

Provides access to Historian power security users. Se-
curity administrators have rights to all Historian func-

tions.

i h_tag_admi ns

Provides access to allow the ability to create, modi-

fy, and remove tags. Tag-level security can override
rights given to other Historian security groups. Tag ad-
mins can also browse collectors.

i h_unaudi ted_| ogi ns

Allow connections to the Data Archiver without creat-
ing login successful audit messages.

ih_unaudited_witers

Provides the ability to write data without creating any
messages. Tag, archive, and collector changes log
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Scope

Description

messages regardless of whether the user is a member
of the ih_audited_writers group.

hi storian_vi sual i zati on. adm n

Provides access to Trend Client and the Web Admin

console.

hi stori an_vi sual i zati on. user

Allows access to Trend Client.

Scopes for Plant Applications Users/Groups

This topic provides a list of scopes you can assign to users/groups for accessing Plant Applications.

By default, Plant Applications administrative users are granted all the scopes. For other type of users, you

need to assign the specific scope to grant access to the respective module.

These are the scopes associated with the different modules of Plant Applications:

Scope Applies To
mes. rout e_nmanagenent . user Route Editor
mes. security_managenent . user Security
mes. ti me_booki ng. user Time Booking
mes. oper at i ons. user Unit Operations
mes. wast e. user Waste
mes. or der _managenent . user Work Order Manager
mes. wor k_queue. user Work Queue

nmes. | i neovervi ew. user

Line Overview

mes. ny_nachi nes. user

My Machines

mes. ncm _nmanagenent . user

Non Conformance

nmes. equi pnent . user

OEE Dashboard

nmes. oper at or | og. user

Operator Log

nmes. process_orders. user

Process Orders

mes. property_definition. user

Property Definition

nmes. recei vi ng_i nspecti on. user

Receiving Inspection




Proficy Authentication | 1 - Proficy Authentication | 58

Scope Applies To
mes. reports. user Repor‘cs
mes. geneal ogy. user Genealogy
mes. activities. user Activities
nes. al ar ns. user Alarm Notifications
mes. al ar ns. user Alarms
mes. anal ysi s. user Analysis
mes. approval _cockpi t. user Approval Cockpit
nes. aut ol og. user Autolog
mes. bom edi t or . user BOM Editor
mes. confi gur ati on_managenent . user Configuration
mes. downt i me. user Downtime
mes. engi neer i ngChangeOr der . user Engineering Change Orders

Create Groups

This topic describes how to create new groups in Proficy Authentication.
Log in to Configuration Hub as an administrator.

For example, you can create a group for users who perform the same task on the same resource.
You can have a group of supervisors for each line such as, Super vi sors_Li neA, Super vi sors_Li neB,

Supervi sors_Li neC.

1. Go to Proficy Authentication > Security > Groups.

2. Select +



Security-Proficy Authentication
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X

Identity PI{:'-.:'I(|E‘[ Users

Q. Search

Group Name I

clients.admin

clients.read

clients_ secret

clientswrite

The Add Group screen appears.

3. Enter the following details for the new group.

Field Description
Group Name A unigue name of the group that does not match with any existing Proficy
Authentication groups. For example, Super vi sors_Li neA
Description A brief description of the group.
Add Group

Group Name*

Supervisors_LineA

Description

Members to monitor Linedl

4. Select Add.

The group is created successfully.

The newly created group is added to the list of groups on the Groups tab.
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Modify Groups

This topic describes how to modify existing groups in Proficy Authentication.
Log in to Configuration Hub as an administrator.

You can modify a group to:

» Add/Remove Users in a Group (on page 64)
» Add/Remove Sub-Groups in a Group (on page 65)
« Map Groups (on page 61)

1. Go to Proficy Authentication > Security > Groups.
The existing list of Proficy Authentication groups appear.
2. Use any of these options to open a group.
> Double-click the group name you want to modify.
> For the group you want to modify, from its ACTION column, select EBEE, then Edit.

The group opens in a new tab.

Lol tE S [ TATETT STl confighub.access-Proficy Authentication

Group

confighub.access -

Member{Users) Mapping Member(Groups)

q Search +

User Name 1 Origir Email
ch_admin uaa ch_admin@test.org
kal_el uaa krypton@gmail.com

phantom uaa devilwolf@gmail.com

3. You can modify the following:

Tab Description

Member (Users) Displays the list of users added to this group. Add/Remove
Users in a Group (on page 64).
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Tab

Description

Mapping

Displays the list of mapped groups for this group. You can add/

remove mapped groups (on page 61).

Member (Groups)

Displays the list of sub-groups added to this group. Add/Re-

move Sub-Groups in a Group (on page 65).

Map Groups

This topic describes how to perform group mapping.

Log in to Configuration Hub as an administrator.

You can map any of the following to a Proficy Authentication group. The users belonging to these groups

gain access to Proficy Authentication, and become a member of the target group.

* UAA groups
« LDAP
* SAML groups

1. Go to Proficy Authentication > Security > Groups.

The existing list of Proficy Authentication groups appear.
2. Double-click and open the group you want to map to UAA/LDAP/SAML groups.

3. Select the Mapping tab.

4. Map UAA groups.

a. From the Identity Provider drop down list, select the UAA record.

The groups from the UAA record appear.

b. Select the check box for the groups you want to map to the Proficy Authentication group

selected in step 2.

c. Select - to move the selected items from Groups to Mapped Groups.
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Group
confighub.access -
Member(Users)  Mapping  Member(Groups)

Identity Provider

uaa -
Groups Mapped Groups
[ ] ispl Dis
v cloud_controller.admin scim.invite
clients.read uaa.resource

clients.secret
uaa.admin -

clients.admin

The users belonging to the mapped UAA groups are now a member of the Proficy
Authentication group selected in step 2.

5. Map LDAP groups.

a. From the Identity Provider drop down list, select the LDAP record.
The groups from the LDAP server appear.

b. Select the check box for the groups you want to map to the Proficy Authentication group
selected in step 2.

c. Optional: To search for an LDAP group, enter the keyword in the LDAP Groups Search Filter

field and select Y .

d. Select - to move the selected items from Groups to Mapped Groups.
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Member(Users)  Mapping Member(Groups)

Identity Provider

UAA LDAP

LDAP Groups Search Filter

(objectclass=*)

Groups

DM

CN=HelpLibraryUpdaters,CN=Users,DC=p...
CN=WSS5_ADMIN_WPG,CN=Users,DC=pa,...

CN=Administrators,CN=Builtin,DC=pa,DC...

CN=Guests,CN=Builtin,DC=pa,DC=com

CN=Print Operators,CN=Builtin,DC=pa,DC...
CN=Backup Operators,CN=Builtin, DC=pa,...

CN=Replicator,CN=Builtin,DC=pa,DC=com

Mapped Groups
DN

CN=5QLServer20055QLBrowserlUser$C...
CN=SQLServerMsASUserfCWARIRSSVRZ...
CN=WS5_WPG,CN=Users, DC=pa,DC=com

CMN=Users,CMN=Builtin,0C=pa,DC=com

The users belonging to the mapped LDAP groups are now a member of the Proficy

Authentication group selected in step 2.

6. Map SAML groups.

a. From the Identity Provider drop down list, select the SAML record.

b. To create SAML groups, enter the valid SAML group name in the Add SAML Group field and
select the plus icon.

Group

cloud_controlleradmin =

Member(Users) Mapping Member(Groups)

ldentity Provider

Okta Legin Station -

Add SAML Group

GIOUpS

Group Name |

c. Select the check box for the groups you want to map to the Proficy Authentication group

selected in step 2.
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d. Select - to move the selected items from Groups to Mapped Groups.
Group

cloud_controlleradmin -

Member(Users) Mapping Member(Groups)

Identity Provider
Okta Login Station -

Add SAML Group

+
Groups Mapped Groups
O Group MNar Group Mame
zl corp_group Secure_sys_group
v action_group «

cloud_group

If the mapped SAML groups are valid, then all their users become a member of the Proficy

Authentication group selected in step 2.

7. To unmap any of the mapped groups, select and move them back to Groups.

UAA/LDAP/SAML groups are successfully mapped.

Add/Remove Users in a Group

This topic describes how to add or remove users from a group.

Modify a group (on page 60) to add or remove users.

1. Select the Member (Users) tab.

2. Select _I_
The Map User screen appears.
3. Select the check box for the user account you want to add to the group.

To remove user from a group, clear the check box.
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Map User
Q. Search
User List 1
ch_admin
kal_el
mandrake_01
V| phantom

WOTE: Mapping supported for UAA users only.

4. Select Apply.

The users are added to (or removed from) the group.

Add/Remove Sub-Groups in a Group

This topic describes how to add or remove sub-groups from a group.

Modify a group (on page 60) to add or remove sub-groups.

1. Select the Member (Groups) tab.

2. Select _I_
The Group Membership screen appears.

3. Select the check box for the group/s you want to add as a sub-group.
To remove a sub-group from a group, clear the check box.
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Group Membership
Q Search

[ | GROUPNAME 1

clients.admin

clients.read
[+] clients.secret
clientswrite
v cloud_controller.admin
confighub.admin
Cancel Apply
! Important:

Do not select the check box for i gp. st udi oAdni n group for any users or groups. As this
group is for reserved purposes, make sure no user accounts or groups are assigned to this
group to avoid runtime errors.

4. Select Apply.

The groups are added (or removed) as sub-groups in the group.

The users added to the sub-groups are automatically associated to the main group.

Delete Group

This topic describes how to delete Proficy Authentication groups.

Log in to Configuration Hub as an administrator.

1. Go to Proficy Authentication > Security > Groups.
The existing list of groups appear.
2. Select the group you want to delete.
Additional options appear under the ACTION column.
3. Select EEE then Delete.
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Identity pIO'JidSElS

Q Search + &

Group Name T Members Action

clients.admin 0

clients.read

Edit

clients.secret 0
clients.write 1
cloud controller admin 0

A message appears to confirm the delete action. The message also informs if users are
associated to the group being deleted.

4. Select Delete.

The group account is deleted from the Proficy Authentication database.

Manage Users

Create Users

This topic describes how to create new users in Proficy Authentication.

Log in to Configuration Hub as an administrator.

1. Go to Proficy Authentication > Security > Users.

2. Select ‘l‘

Security-Proficy Authentication

Identity Provider Groups

Q. Search

User Name T Email Crigin Action
ch_admin ch_admin@test.org uaa
kal_el krypton@gmail.com uaa
mandrake_01 magician@gmail.com uaa

phantom devilwolf@gmail.com uaa
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The Add User screen appears.

3. Enter the following details for the new user account.

Field Description
User Name The user name to log in to Proficy Authentication.
Password The password to log in to Proficy Authentication.
Confirm Password Enter the password again for confirmation.
Email User's email address.
Add User
User Name®
sys_admin
Password®
....... &

Email®

pacman@gmail.com

Cancel Add

4. Select Add.

The user is created and added to the list of user accounts on the Users tab.

The new user is associated to default Proficy Authentication groups. These default groups
cannot be deleted or modified: approval s. ne, cl oud_control | er.read, cl oud_control ler.wite,
cloud_controll er_servi ce_perm ssions. read, oaut h. approval s, openi d, password. wite,profile,roles,

scim e, sci m userids, uaa. of fl i ne_t oken, uaa. user, user_attri butes.
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Every user/client must possess the following three scopes to access the Security plug-in via Configuration

Hub. If these scopes are not added, then a warning message alerts the user to contact Admin.

Scope

Description

uaa. adm n

This scope indicates that this is a superuser.

clients.wite

This scope resets the Security plug-in's admin client secret.

password. wite

This admin scope enables to change the user password.

Note:
This scope is assigned to all the UAA/LDAP/SAML users by default

without the need to assign manually.

Default ch_adni n has all the three scopes.

For user accounts originating from LDAP or SAML, refer to Add LDAP/SAML Users (on page 69).

Add LDAP/SAML Users

This topic describes how to add LDAP/SAML users to Proficy Authentication.

You must have an LDAP or SAML user account.

Only user accounts created in Proficy Authentication are immediately visible in the users list. LDAP or

SAML users must perform the following steps to create user accounts in Proficy Authentication.

Log in to Proficy Authentication with LDAP/SAML user credentials.
A shadow user is created in Proficy Authentication, and can be subsequently seen in the Proficy

Authentication users list.

The LDAP/SAML user account is added to the list of accounts on the Users screen.

Add/Remove Groups for a User

This topic describes how to modify group membership for existing user accounts.

Create Users (on page 67)

While it is possible to assign multiple scopes/groups to clients and users, it is advisable to exercise

caution and follow these recommendations:
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- Adhere to the principle of least privilege: Applying this principle helps to minimize potential
security risks. It advocates to grant users only the necessary privileges and permissions to
perform their tasks effectively. If you assign too many scopes to users, it can lead to unnecessary
privileges, thus increasing the attack surface and potential for unauthorized access.

+ Keep the token size within acceptable limits: The size of an Access token or JWT (JSON Web
Token) commonly used for authentication and authorization purposes, can vary depending on the
number of scopes assigned to a user. If a user has an excessive number of scopes, the size of the
JWT can become significant. As a result, when the user attempts to access an application, the
HTTP requests made by the application to validate the token may get impacted. In case the default
settings of the web server hosting the application has limitations on request size, then the request
can get blocked or rejected if the token size exceeds the set limit.

1. Go to Proficy Authentication > Security > Users.
The existing list of user accounts appear.

2. Select the user account for which you want to modify group membership.
The existing information for the user appears on the DETAILS panel.

3. Select [:'Jz next to the GROUP MEMBERSHIP section.

ch_admin

Q. Search

» GENERAL

% GROUP MEMBERSHIP @
uaa.admin
scim.write

The Group Membership screen appears.

4. Select the check box for the groups you want to add the user as a member.
To remove a group, clear the check box.
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Group Membership

[ | GROUPNAME 1

clients.admin

w clients.read
clients.secret
w clientswrite
cloud _contraoller.admin
o confighub.access
Cancel Apply
! Important:

Do not select the check box fori gp. st udi oAdmi n group for any users or groups. As this
group is for reserved purposes, make sure no user accounts or groups are assigned to this

group to avoid runtime errors.

5. Select Apply.

The groups are added (or removed from) for the user.

(g
Note:
If a logged-in user attempts to remove his/her own scopes/groups, the remove operation may fail
and result in an error: Error whi | e assigning the group. In such instances, the user should log

out of the Configuration Hub application and log-in again. We recommend that logged-in users

should avoid removing their own scopes.
-

~

Reset User Password

This topic describes how to reset passwords for Proficy Authentication users.

Log in to Configuration Hub as an administrator.

1. Go to Proficy Authentication > Security > Users.

The existing list of user accounts appear.
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2. Select the user account for which you want to reset the password.
The option to reset password appears on the DETAILS panel under the PASSWORD section.

Security-Proficy Authentication

Identity Provider  Groups  Users phantarn
0, 5e

Q, Search + &

User Name 1 ma Origi Action » GEMERAL

ch_admin ch_admin@test.ong uaa S GROUPMEMBERSHIP &

kal_el kryptoni@gmail.com uaa )
~  PASSWORD

mandrake_01 magician@gmail.com uaa

Last Maodified 04/01/2022, 2.

phantom devibwolf@gmail com

Last Logon

ResetPassword

3. Select RESET.
The Password Reset screen appears.

4. Enter the new Password and Confirm Password for the user account.

Password Reset

User Name®

Password®

Confirm Password*

Cancel ResetPassword

5. Select Reset Password to apply the changes.

The password is reset for the user.

Delete User

This topic describes how to delete Proficy Authentication user accounts.

Log in to Configuration Hub as an administrator.
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1. Go to Proficy Authentication > Security > Users.
The existing list of user accounts appear.

2. Select the user you want to delete.
Delete option appears in the ACTION column.

Identity Provider Glot!p

Q, Search + &
User Name 1 mai Origir
ch_admin ch_admin@test.org
kal_el krypton@gmail.com uaa
mandrake_01 magician@gmail.com uaa
phantom devilwolf@gmail.com uaa
e
T
3. Select 141,

A message appears to confirm the delete action.
4. Select Delete.

The user account is deleted from the Proficy Authentication database.

Windows Integrated Authentication / Auto-login

Windows Integrated Authentication is a new capability added to Proficy Authentication Service from

version 2022.

When Windows Integrated Authentication or Auto-login is enabled, users logged into any Windows
machine in a domain are able to access Operations Hub and/or hosted Proficy applications without the
need to type in their Windows credentials again. The same Windows logged-in user context is used for
authenticating the user. Based on the user's privileges, access is provided to Operations Hub and/or its
hosted applications.

This document describes the steps to configure the 'Windows Integrated Authentication’ functionality
in an instance of Proficy Authentication service. After configuring auto-login, when you attempt to log
into Operations Hub / hosted Proficy applications, the Select Authentication screen appears (see figure
below) to choose between st andard Proficy Authentication LoginOr Active Directory (W ndows)

I ntegrated Login.
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If you choose Active Directory (Wndows) Integrated Login,the authentication option will follow

the new flow and you will not be prompted for providing credentials. Whereas choosing st andar d

Proficy Authentication Login will take you through the normal authentication flow and prompt for your

credentials.

-~

Note:

scope.

« The auto-login capability is only for authenticating the users. For authorization or access
permissions, you have to configure LDAP IDP. To accomplish this, select the same active
directory service / LDAP server, which brings the authentication service node, application
accessing nodes in the network, and the users seeking auto-login, into the same Windows

« For configuring LDAP IDP, refer to Add LDAP Identity Provider (on page 15).

Select Authentication

® Standard Proficy Authentication Logmr

Active Directory [Windows) Integrated Lomn

Standard Proficy Authenti-
cation Login

Choose this option if you want to use the standard login (username/pass-
word or SAML).

This is a regular login, which is based on username/password, including
LDAP, or SAML.

Active Directory (Win-
dows) Integrated Login

This option appears only if Windows auto-login is configured.

This allows to automatically log into Operations Hub using the user's do-
main login session that was used to log in to Proficy Authentication.

Don't ask me again

Select this check box, if you don't want to display the Select Authentication
screen every time you login.

The system remembers the last selected authentication (between regular
and autologin) and applies it for future logins.




Proficy Authentication | 1 - Proficy Authentication | 75

With Don’t ask me again enabled, you can clear the last selected authenti-

cation only during logout.

You have logged out

You should now close the browser
or click here to login again.
You may also click here to clear the

previgusly selected authentication option.

Select You may also click here to clear the previously selected authentica-
tion option to clear the saved selection. Once cleared, the clearing option is
hidden from the logout screen.

Select click here to login again to return to the login page.

Defer

Select to dismiss this screen, and skip selecting an authentication. You

have the choice to select authentication next time you login.

To configure Windows Auto-login, an administrator performs the following tasks only for the first

time. The first task is performed on all the participating nodes (Active Directory service node, Proficy

Authentication service node, and the client nodes). The second and third are performed on the

Windows Active Directory Server machine. The fourth task is performed on the machine where Proficy

Authentication is installed.

1. Configure Security Policy (on page 76).

2. Create a service principal for your user account (on page 78).

3. Generate the Kerberos keytab file (on page 81).

4. Update the Proficy Authentication .yml file (on page 84).

5. Add LDAP Identity Provider (on page 15) for the Active Directory service used in Steps 2 and 3.

Note:

Users logging into DPM products using Windows Auto-login are authorized / get the

scopes based on the LDAP configuration performed in Step 5.

To configure the browser settings for Windows Auto-login, the following task is performed on the end-user

machine.
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« Configure the browser settings for Kerberos authentication (on page 85).

Figure 1. Windows Auto-login - Deployment Topology and Configuration

ex: uag.tesf.ge.com

All the three participating nodas are in the same realm.

______________ Windows Server hosting

Active Directory Service / KDC

Actions :

1. Ensure that the security pelicy setting
Network security: Configure encryption types
aliowed for Kerberos'is set to same

Elient node accassing Proficy-Authentication Service
from Browser

Actions :

1. Ensure that the security policy setting for Network
security: Configure encryption types aliowed for Kerberos'is
set to same encryplion types as it is on Active Directory
server and the Proficy Authentication service node

2. Launch Internet Explorer and open 'Internet Options'
3. Open "Security” tab and select 'Local Intranet'.

4. Click the 'Sites’ button and add the url of the

Proficy Authentication service to the existing

sites list
5. For the Windows Integrated Authetication use
UseKerbAuth' query parameter while accessing the Proficy
Authentication Service URL, like
https:/fqdnoftheproficyauthneticationservice/uaal?
UseKerbAuth=trus

Configure Security Policy

encryption types as it is on Proficy
Authentication Service node and the Client
node(s).

2. Generate SPN for the Proficy
Authentication service

3. Generate a keyiab file with the SPN

Windows Server hosting Proficy Authentication Service

Actions :

1. Ensure that the security policy setting for Nefwork security: Configure
encryption types allowed for Kerberos'is set to same encryption types as it is on
Active Directory server and the Client node(s).

2. Copy the keytab file from AD server and paste on this machine
in any path

3. Edit the section ‘kerberos’ in the uaa.ymi file (C\ProgramData\GE\Operations
Hub\uas-cenfig) with SPN name (generated on the Active Directery server ) and
local keytab file location.

4. Using the Security Administration Tool or Security plug-in in ConfigHub configure
the same Active Directory server as LDAP IDP.

This topic describes how to configure security policy setting associated to Kerberos authentication.

It is possible that you may not have access to your computer’s local security policy settings, if it is
governed by a group policy (controlled by your domain administrator). In any case, make sure that these
security options are enabled for your computer.

If your environment is not governed by a group policy, then follow these steps to configure local security
policy:
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1. To access Local Security Policy, enter secpol . msc in Windows Run dialog and select OK.

= Ruif X

5 Typt the name of a program, felder, document, or Intermet |
resource, and Windows will open it for you.

=
open: | IETERR ]

Cancel

2. Navigate to Security Settings > Local Policies > Security Options.

» @ User Rights Assignment
» i Security Options
» ] Windows Defender Firewall with Advai
- Metwork List Manager Policies
» [ Public Key Policies
*| Software Restriction Policies
» [] Application Control Policies
» 3 1P Security Policies on Local Computer
» ] Advanced Audit Policy Configuration

:h: Metwork access: Shares that can be accessed anonymously

Ly, Metwork access: Sharing and secunty model for local accounts

i, Metwork security: Allow Local System to use computer identity for.
s, Metwork security: Allow LocalSystem NULL session fallback

o, Network security: Allow PKU2U authentication requests to this co..
‘ Metwark security: Configure encryption types allowed for Kerberos
5 Network security: Do not store LAN Manager hash value on next ..
:,:5 Metwaork security: Force logoff when logon hours expire

jﬁ Metwark security: LAN Manager authentication level

il i ignin ir

i Local Security Policy - ] b
File Action View Help
o 2nm XE )
=Y Security Settings Policy Security Setting -
ra Account ch.ahmes i, Network access: Remotely accessible registry paths and sub-paths  System\CurrentControlS..
v -a Loc:l P:IH-;: 5 Metwork access: Restrict anonymous access to Named Pipesand . Enabled
<@ Audit Policy i, Metwork access: Restrict dients allowed to make remote calls to 5. Mot Defined

Classic - local users auth..
Disabled

Mot Defined

Disabled

AES128_ HMALC_SHA1AES.

Enabled
Disabled
Send NTLMv2 response ..

3. Double-click and open Net wor k security: Configure encryption types allowed for Kerberos

security policy setting.

4. Select the valid encryption types that you want to use as shown in the figure. Ensure that the

selection is same across all the participating nodes.

You can select either AES128_HVAC _SHA1 Or AES256_HMAC_SHA1 as the encryption type. Also select the

Future encryption types option.
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Metwork security: Configure encryption types allowed for ... 7 *

Local Security Setting  Explain
} Metwaork security: Configure encryption types allowed for Kerberos
¢

—TCTY - -
RC4_HMALZ MDS5 [
AES128_HMAC_SHA1
AES256_HMAC_SHA1
Future ancrypion types i v

& O

o] om0

-

Note:

In our current documentation, we use AES256_HVAC_SHAL encryption type in our example

code to generate the keytab file (on page 81).

N

For more information refer to Microsoft documentation on security policy settings.

Create Service Principal Name

This topic describes how to create a service principal name.


https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-r2-and-2012/dn452420(v=ws.11)#to-configure-a-setting-for-your-local-computer
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« Create a managed service user account on the Active Directory Server node to represent the
Proficy Authentication application in the active directory registry. Make sure to implement these
settings for the account:

o It is mandatory user is a member of the domain user group. Refer to Microsoft
documentation for more information.

o Set the account password to never expire. To do so, access the domain user account
properties dialog: Account > Account options > Password never expires.

File Action View Help
o 2@ F0/XCE=2 Hm 8aETYE%R

I . Active Directory Users and Comp

Nar'r” . . . . 2
3 Saved Queries E)G Service Account Proficy SPN Autologin Properties g X
. eSO H%G  Published Centficates  Member Of  Password Replication  Diakin ~ Object
= Bulktin %G Security Environment Sessions Remote control
d Computers 53(3 Remote Desktop Samvices Profile COM+ Attribute Editor

. o Sonimiers %G General  Address  Account Profle ~ Telephones  Organization

2| Enterprise !EG
| ForeignSecurityPrincipals User logon name:

7 Keys =55 e w
8 LA S &G User logon name (pre-Windows 2000):
» | Managed Service Accoun OlE UMT:S'F'. : ST
3l MFG & i s
1P K
g Tl & Logon Hours... Log On To...
_ System E.;k
| Users %h
| NTDS Quotas & p [ Unlock account
“| TPM Devices an
E} n  Aecount options:
&N (] User must change password at next logon e
E) N [_] User cannot change password
& p (] Password never expires
%p || Store password using reversible encryption v
&B R Account expires
%R e Never
Eb: (O End of: 02 March 2023
s
&

%z II' Cancel Apply Help



https://learn.microsoft.com/en-us/microsoft-desktop-optimization-pack/medv-v1/how-to-configure-a-domain-user-or-groupmedvv2#how-to-add-a-domain-user-or-group
https://learn.microsoft.com/en-us/microsoft-desktop-optimization-pack/medv-v1/how-to-configure-a-domain-user-or-groupmedvv2#how-to-add-a-domain-user-or-group
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« Configure Security Policy (on page 76)

A

= - .

7

File Action View Help

& 20 40 XEcz H ai3TE%

1 Active Directory Users and Comp
» | Saved Queries

.4 §3 uaatestad.gecom

| Builtin

Computers

Domain Controllers

Enterprise

ForeignSecurityPrincipals

Keys

LostAndFound

Managed Service Accoun

Program Data

System

Users

NTDS Quotas

TPM Devices

Ma s Tura Diac rrintiom

8, | uaaautologin Properties ? x
% Organization ~ Published Certificates  Member Of  Password Replication
g Dial-in Object Secunty Enviranment Sassions
% Remote control  Remote Desktop Services Profile COM+  Attribute Editor
& General Address Account Profile Telephones Delegation
#,|  Userlogon name:

8 HTTPluasautologini.uaatestad.ge.c @uaatestad ge.com =
%ﬁ User logon name (pre-Windows 2000):

%' UAATEST\ uaaautologin

$= Logon Hours... Log On To...

g' [ Unlock account

E: Account options:

%l ["] Use only Kerberos DES encryption types for this account Cu
E ["] This account supports Kerberos AES 128 bit encryption.

&“ [l This account supports Kerberos AES 256 bit encryption.

E;. [ Do not require Kerberos preauthentication =
&‘ Account expires

% | (®) Never

%" O End of: 27 January 2023

3 (o] om [ A e

Note:

Delete existing SPNs, if any. Refer to Useful SPN commands (on page 126).

You must be an administrator to perform this task.

1. Log in to the machine where Proficy Authentication is installed.

2. Open the Windows Command Prompt application.
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3. Run the following command replacing with the appropriate code: set spn -S HTTP/ <FQDN> <user

account >

Code Replace With

<FQDN> Fully Qualified Domain Name (FQDN) of the server on which Proficy

Authentication service is running.

For example, HTTP/ phant onhost . uaat est ad. ge. com@JAATESTAD. GE. COM

o ™\
Note:
These should be in capital letters:

o HTTP

o UAATESTAD. GE. coM(the domain name that follows @)
- J

<user account > Dedicated managed service user account created for Proficy Au-

thentication service.

For example, ghost 1.

Based on the above examples, your code should look like this: set spn -S HTTP/
phant omhost . uaat est ad. ge. com@QJAATESTAD. GE. COM ghost 1

The service principal name (SPN) is created.
Generate Keytab File (on page 81)
Generate Keytab File

Generate the Kerberos keytab file.

Create Service Principal Name (on page 78)

You must be an administrator to perform this task.

1. Log in to your system and open the Windows Command Prompt application.
2. Run the following command replacing with the appropriate code: kt pass -out <filename> -princ
HTTP/ <servi ce pincipal nane> - mapUser <user account> -mapQOp set -pass <password> -Crypto AES256-

SHA1L - pType KRB5_NT_PRI NCI PAL
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Code

Replace With

<fil enanme>

Name of the keytab file.

Note:

Keytab file name can be any given name.

The file is created at the default location. You also have the option
to specify an absolute path for file creation. For example, - out c:

\ Docurent s\ myskul | cave. keyt ab.

<servi ce pincipal nane>

Enter the service principal name that was created in the following

format: HTTP/ phant omhost . uaat est ad. ge. com@QJAATESTAD. GE. COM

<User account>

Enter the same managed service user account that was used dur-

ing creating the service principal name.

For example, ghost 1.

(L ™
Note:
If you want to use a different user account, delete the ex-
isting user account, (or) rename the logon name in the

user account.
- /

<passwor d>

Proficy Authentication managed service user account password.

AES256- SHA1

Encryption algorithm you want to use.

Note:

GE recommends AES256- SHAL. But you can also use

AES128- SHAL.

KRB5_NT_PRI NCI PAL

Encryption type you want to use.

If the keytab is successfully created, the log should look something like this:

C:\ User s\ Admi ni strat or >kt pass -out c:\Tenp\ SACH NJOHUB21VM uaat est ad. ge. com keytab -princ

HTTP/ SACHI NJOHUB21VM uaat est ad. ge. COmM@QAATESTAD. GE. COM - napUser Mark -nmapOp set -pass Gei 32litc -crypto

AES256- SHAL - pType KRB5_NT_PRI NCI PAL

Targeting domain controller:

uaat est ad. uaat est ad. ge. com
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Usi ng | egacy password setting nmethod

Successful |y mapped HTTP/ SACH NJOHUB21VM uaat est ad. ge. com to Mar k.

Key created.

Qut put keytab to c:\Tenp\ SACH NJOHUB21VM uaat est ad. ge. com keyt ab:

Keyt ab version: 0x502

keysi ze 105 HTTP/ SACH NJOHUB21VM uaat est ad. ge. com@JAATESTAD. GE. COM ptype 1 (KRB5_NT_PRI NClI PAL) vno 3 etype 0x12

(AES256- SHA1) keyl ength 32 (0x3f b2a2824864a6b3617bf a4a6458af 83534ef db8a3eac08b02316cce9csdee’f c)

Example of a failed log:

C: \ W ndows\ syst enB2>kt pass -out c:\Tenp\w nl6-sachi n. uaat est ad. ge. com keytab -princ
HTTP/ sachi n. uaat est ad. ge. coOm@JAATESTAD. GE. COM - mapUser John - mapQp set -pass Gei 321litc -crypto AES256- SHAL
-pType KRB5_NT_PRI NCI PAL
Targeting domain control |l er: uaatestad. uaatestad. ge. com
Usi ng | egacy password setting nethod
Failed to set property 'userPrincipal Nane' to 'HITP/ sachi n. uaat est ad. ge. COm@AATESTAD. GE. COM on Dn
' CN=John, CN=User s, DC=uaat est ad, DC=ge, DC=coni : 0x13.
WARNI NG Failed to set UPN HTTP/ sachi n. uaat est ad. ge. com@JAATESTAD. GE. COM on
CN=John, CN=User s, DC=uaat est ad, DC=ge, DC=com
kinits to ' HTTP/ sachi n. uaat est ad. ge. cOm@QAATESTAD. GE. COM wi || fail.
Successful |y mapped HTTP/ sachi n. uaat est ad. ge. comto John.
Key created.
Qut put keytab to c:\Tenp\w nl6-sachin. uaat estad. ge. com keyt ab:
Keyt ab version: 0x502
keysi ze 102 HTTP/ sachi n. uaat est ad. ge. com@QJAATESTAD. GE. COM ptype 1 (KRB5_NT_PRI NCl PAL) vno 9 etype 0x12

( AES256- SHA1) keyl ength 32 (0x8b551a22050935e9ace848cachacc86a4eb845e63b6461d4f 31b7d815158cf 6¢)

You can also do the following to verify if the service principal is mapped to the managed service user
account, and a keytab is created:

1. Go to Active Directory Users and Computers > Users.
2. Access the properties of the user account for which you created the keytab file.
3. On the Account tab, verify User logon name. is pointing to your service principal name.
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T Active Directory Users and Compd| name e Description

y = Queries &, rdmiristrator User Built<in account for admin.

v mun-:.‘f‘.grmm B tllowed RODC Passward Rep.. Security Group . Members inthis group ca..
j g:::mm H3, Cent Publishers Security Group . Membiers of this group ar-

!Eclcm:\ahlr Domain Contrellers Seounty Group - Membiers of this group the

: : ED::::;WmIIm E, Denied RODC Passweord Repl_  Security Group - Memhers-m_lh profusa Properties ) »
» B Foreignsecuritybrindpals B2, Dretdrnins Security Group = DNS Admiristr
> B Keps B2, BrsUpdateProxy Security Group _  DNS dients wh ¢ Publishod G MemberOf  Password Replontion
7 LostAndFound %Dﬁmain.ﬁdmins Secunty Group - Designated ad Diakin Ohjoct Security Envimnment Spssions
| Managed Senice Account %Domain(omputers Security Group - All workstation  Remole contrel Remole Deskiep Sendces Profie  OOMs+  Aliribute Editor
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- Copy the keytab file on the machine, where Proficy Authentication is installed.
- Update the Proficy Authentication uaa.yml file (on page 84).

Proficy Authentication Service Configuration

This topic provides steps to update the Proficy Authentication uaa. ym file.

Make sure you have completed the following tasks:

+ Generate Keytab File (on page 81).
« Copy the keytab file from the Active Directory server, and paste it anywhere on the Proficy
Authentication machine.

« Make a note of the keytab file location on the Proficy Authentication machine.
You must be an administrator to perform this task.

1. Log in to the computer machine where Proficy Authentication is installed.
2. Access the uaa. ym file.
The file is located at C: \ Pr ogr anDat a\ Pr of i cy\ Oper ati ons Hub\ uaa- confi g\ uaa. ym
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3. To modify, open uaa. ym in any text editor.
Example: Notepad++
4. Search for ker ber os and enter values for the following keys:

service-principal Enter the service principal name. For more information, refer to Create

Service Principal Name (on page 78).

keytab-location Enter the location path where you copied the keytab file on this ma-
chine.
For example:
ker ber os:

servi ce-principal: HTTP/ phant onhost . uaat est ad. ge. COmM@JAATESTAD. GE. COM

keytab-1ocation: 'file:///C: /ProgranData/ GE/ Proficy Authentication/uaa-config/ nyskullcave. keyt ab’

5. Save and close the modified file.

6. Restart the GE Proficy Authentication Tontat Wb Server Service.
a. Access the Windows Run dialog.
b. Enter servi ces. msc to open the Services screen.

c. Right-click GE Proficy Authentication Tontat Wb Server and select Restart.

The Proficy Authentication service configuration is updated .
Configure Browser
Configure the browser settings for Kerberos authentication.

Windows Auto-login works if the following tasks are accomplished.

« Create Service Principal Name (on page 78)
+ Generate Keytab File (on page 81)

« Proficy Authentication Service Configuration (on page 84)

The steps describe how to configure the browser settings on Internet Explorer (IE). Since IE settings are

shared by Chrome, you do not have to configure it separately for the Chrome browser.

Important:
Windows Auto-login is not supported on the node where the Proficy Authentication service is
running. To enable auto-login, configure the browser settings on a node different from the Proficy

Authentication service node.
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1. Go to Control Panel > Internet Options
The Internet Properties dialog appears.
2. On the Security tab, select Local intranet > Sites.
The Local intranet window appears.
3. Select Advanced.
4. In Add this website to the zone, enter the URL of the Proficy Authentication service, and then select

Add.

¢* Local intranet *

¥  Youcan add and remove websites from this zone. All
websites in this zone will use the zone's security settings.

Add this website to the zone:
ImpS:,-'.-*wimﬁ-phantcmhust.uaatestad.ge.corrﬂ Add

Websites:

* ad.sys f* Remove
*.alstom.com

* eqlals.lan

10.93.16.101

10.93.16.149 W

[] Require server verification (https:) for all sites in this zone

Close

5. Select Close.
6. Select OK to close the open windows.

Kerberos supported SPNEGO authentication is enabled on your IE browser.

For Windows Auto-login, use UseKer bAut h query parameter while accessing the Proficy Authentication

service URL. For example, ht t ps: // FQDN of the Proficy Authentication Service Node/ uaa/ ?UseKer bAut h=t r ue

Example Configuration for Multi-domain and Auto-login
Functionality

This topic describes how to set up the auto-login with multi-domain functionality so that users can

automatically log in to multiple domains without having to enter their credentials for each domain login.
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You should have administrative access to perform the steps described below. You need virtual machines

(VM servers) to host the following:

« Forest1 VM server named FORESTPLANT in this topic.

* Forest2 VM server named FORESTCORP in this topic.

» VM server where Proficy Authentication is installed, and can also be utilized for testing purposes.

- However in this topic, we use a separate VM server for testing auto-login with multi-domain
functionality.

Benefits of Auto-login with multi-domain functionality:

- eliminates the need for users to remember and enter separate user names and passwords for each
domain.

- seamless user experience by automatically logging them across multiple domains with a single
authentication event.

« users can save time and effort by avoiding repetitive login procedures.

« while auto-login simplifies the login process, it can also enhance security. It allows for the use
of stronger, complex passwords since users don't need to remember them. It reduces the risk of

password reuse or weak passwords, which are common security vulnerabilities.

1. Identify the domains where you want to enable auto-login with multi-domain functionality. We shall
use the following domains:
o FORESTPLANT
o FORESTCORP
2. Create a domain trust between FORESTPLANT and FORESTCORP.
You can refer to the following links for more information.
o https://www.youtube.com/watch?v=F7DgXAXNnC8
o How trust relationships work for forests in Active Directory
o Understanding the Global Catalog
> Global Catalog and LDAP Searches
> Nesting groups
3. Log in to the VM server where you can access Proficy Authentication, and create two LDAP
accounts, one for each Forest.
Refer to Add LDAP Identity Provider (on page 15) for steps to create a LDAP account.
While creating the LDAP accounts, make sure you do the following:


https://www.youtube.com/watch?v=F7DgXAXNnC8
https://learn.microsoft.com/en-us/azure/active-directory-domain-services/concepts-forest-trust
https://learn.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2008-R2-and-2008/cc730749(v=ws.10)
https://learn.microsoft.com/en-us/previous-versions/windows/it-pro/windows-2000-server/cc978012(v=technet.10)
https://learn.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2003/cc776499(v=ws.10)
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> For LDAP server URL address, use port 3268 if the global catalog is enabled. This port
provides access to a broader range of directory information across multiple domains within
the forest. For example: user attributes, group memberships, and other directory objects. In
case the global catalog is not enabled, then use 389 or 636 ports.
o Include the Active Directory forest name in the URL. For example:
= | dap://adl. f orest pl ant. ge. com 3268/

= | dap: // ad2. f orest corp. ge. com 3268/

Security-Proficy Authentication DETAILS

identity Provider  Grewups  Users FORESTPLANT
Q Search

Q Search o+ &

Klentity Providers T Action = T =

 FORESTCORP idap R Trr——

FORESTPLANT URL* Idapc//FORESTPLANT FORESTPLANTLOCAL: 3268/

uaa uaa User DN CH=PLANTUSERLIQ,CN=Users, DC=FORESTPLANT,DC=LOCAL
Crigin Key FORESTPLANT

' (OTHER SEARCH CRITERIA

Group Base CH=Users,DC=FORESTPLANT,DC=LOCAL
User Base Ch=Ugers, DC=FORESTPLANT,DC=LOCAL
User Filter sAMAccountMame=[(0}
Group Filter member={0]
Authenbication = DETAILS
Mdentity Provider  Groups  Users FORESTCORP
Q Search
3 Search o + @
Identity Providers Type Action -v GENER.;L
FORESTCORP Idap Name FORESTCORP
FORESTPLANT Idap URL® dapa/FORESTCORF.FORESTCORPLOCAL: 3268/
[T ] uaa User DN CN=CorpUsers, CN=Users, DC=FORESTCORP,DC=LOCAL
Origin Key FORESTCORP

' OTHER SEARCH CRITERIA

Group Base DC=FORESTCORP.DC=LOCAL
User Base DC=FORESTCORP,DC=LOCAL
User Filter userPrincipalMarme={0)
Group Filter member={0])

Sl ElL 4

4. Log in to any one of the Active Directory forest, and perform the steps described in the following
topics:
a. Configure Security Policy (on page 76)
b. Create Service Principal Name (on page 78)

c. Generate Keytab File (on page 81)
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d. Proficy Authentication Service Configuration (on page 84)
e. Configure Browser (on page 85)
5. Log in to the test VM and validate the trust relationship for authentication and accessing resources

across multiple domains.

Other user
Other user

plant_User2

Sign in to: FORESTPLANTO

FORESTCORPNCarpliser2

Sign in to: FORESTCORPO

How do | sign in 1o another domain?

High Availability

Configure High Availability for Proficy Authentication

This topic describes how to set up a highly available server for the Proficy Authentication service that is

based on the Windows failover cluster and iSCSI technologies.
You need:

» One Windows Server 2019 virtual machine to serve as iSCSI Target.

« Two Windows Server 2019 virtual machines to serve as iSCSI Initiators:
o A primary node (Node1) server
o A secondary node (Node2) server

The following image illustrates the simplest form of deploying the Windows failover cluster and iSCSI
technology-based high available solution for the Proficy Authentication Service.
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iscsl o —
target server . | Iscsl
I | Wirtual Disk

Windows Server fail-over cluster
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N AT ArY :
. . * 15CS51 initiator

[ : - - . A * PostgreS0L Server
I 1Y * Proficy Authentication Sarvice
v ) e L
. MNode 1 MNode 2 .

Client nodes { Browser / Operations Hub / Config-Hub )

In failover cluster technology, a group of independent computers work together to increase the availability
and scalability of clustered roles (identified as nodes in a cluster). Nodes are clustered server machines

running applications and services.

Failover cluster feature and file server roles are installed on the Node1 and Node2 servers (also called
iSCSl initiators). A virtual disk is created on the iSCSI target server for shared storage. Failover clustering
technology arranges for a backup server whenever the primary server has failed for any reason. So, if the
primary server Node1 is down, then the backup server Node2 is automatically activated to replace the
role of the primary server. This ensures uninterrupted access to shared storage and continuity of services

even during failure of the primary server.

1. Set up the iSCSI Target.
a. Configure iSCSI Target (on page 91)
b. Create a Virtual Disk (on page 94)
2. Set up the iSCSl initiators: Node1 and Node2.
a. Configure iSCSI Initiator (on page 91)
b. Initialize a Virtual Disk (on page 95)
3. Open Failover Cluster Manager on any of the iSCSI initiator nodes in a cluster (Node1 or Node2),
and create a cluster (on page 97).
4. Create and configure a role for the failover cluster. See Configure Role (on page 102).

5. Install Proficy Authentication on both the nodes.
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See Configure Proficy Authentication Installation (on page 107).

If you are installing Operations Hub in a highly available cluster, follow the steps as described in

Prerequisites for Installing Operations Hub with External Proficy Authentication (on page 112).

6. Restart the services on both the nodes.

Configure iSCSI Target

This topic describes how to configure an iSCSI target server.

You can configure an external storage using Windows 2019.

1. Log in to the virtual machine where you want to set up the iSCSI target server.

2. Go to Start > Administrative Tools > Server Manager.

3. From the Server Manager dashboard, select Manage > Add roles and features.

4. Complete Add Roles and Features Wizard with these options:

Section

What To Do

Before You Begin

Skip to the next section.

Installation Type

Select Role-based or feature-based installation.

Server Selection

a. Choose the option Select a server from the server pool.
b. Under the server pool section, select your target server. You
will be installing the role/feature on this server.

Server Roles

In the roles list box:
a. Expand File and Storage Services > File and iSCSI Services.
b. Select the check box for iSCSI Target Server.

Confirmation

Select Install.

When the installation is complete, restart the machine.

Log in to the same server again and create a virtual disk (on page 94).

Configure iSCSI Initiator

This topic describes how to configure an iSCSI initiator and connect to the target server.

Configure iSCSI Target (on page 91).
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You must perform these steps on all the initiator server nodes you want to add to a cluster. Let us assume

you are setting up a basic two-node cluster, where there are two iSCSI initiators:

« A primary server called Node1

* A secondary server called Node2

1. Log in to the Node1 server.

2. Go to Start > Administrative Tools > Server Manager.

3. From the Server Manager dashboard, select Manage > Add roles and features.
4. Complete Add Roles and Features Wizard with these options:

Section What To Do
Before You Begin Skip to the next section.
Installation Type Select Role-based or feature-based installation.
Server Selection a. Choose the option Select a server from the server pool.

b. Under the server pool section, select your Node1 server. You

will be installing the role/feature on this server.

Server Roles In the roles list box:
a. Expand File and Storage Services > File and iSCSI Services.
b. Select the check box for iSCSI Target Server.

Features To allow the installation of Failover Cluster Manager:
a. In the features list box, select the check box for Failover Clus-

tering.

The Add features that are required for Failover Clustering?
screen appears, which shows the dependencies that are in-
stalled with this feature.

b. Select Add Features.

Confirmation Select Install.

The selected role and feature is installed on the Node1 server.
5. When the installation is complete, restart the machine.
6. Log in to the same server again and launch Server Manager.

7. From the Tools menu, select iSCSI Initiator.
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8. In the Target field, enter the iSCSI target server address.
9. Select Quick Connect.

If connected, the login success appears as shown in the following figure:

Targets | Dacovery | Favorne Targets | Vokumes and Devioes | RAGIS | Coniguraton |
Quick Connest

T decover and log on 1o 8 target weng & basc cornection, type e P address or

Tapet | e SR S8 | Quick Correct...
Disozvered trgets

Targets that are avallable for connecton al the [P address or DS name that yo
prarvcied ane e bk, Iilun:lrumnmiﬂ.mmﬁum
Ao each target ndrecuslly.

Connections made hene wil be added to the et of Favorite Tangets and an athe
fo reshore fhem wll e rade every bme S computes restarts,
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10. Select Done, then OK to exit.

11. Log in to the Node2 server and repeat steps 1-9.

Initialize a Virtual Disk (on page 95)

Create a Virtual Disk

This topic describes how to create an iSCSI virtual disk and configure the access server.

You must first configure the iSCSI target server (on page 91).

1. Log in to the iSCSI target server.

2. Go to Start > Administrative Tools > Server Manager.

3. Go to File and Storage Services > iSCSI.
4. From the TASKS drop-down menu, select New iSCSI Virtual Disk.
5. Complete New iSCSI Virtual Disk Wizard with these options:

Section

What To Do

iSCSI Virtual Disk Loca-
tion

The iSCSI target server and volume details are displayed.

iSCSI Virtual Disk Name

Enter a name for the virtual disk. For example, shar edDi sk

iSCSI Virtual Disk Size

a. Enter the disk size. For example, 10G8. The disk size depends
on your database utilization and number of users.
b. Select Dynamically expanding.

iSCSI Target

Select New iSCSI target.

If the target is new, then it should be assigned later as described in
step 8.

Target Name and Access

Enter a name for the iSCSI target server. For example, hauaat ar get

Access Servers

Add the iSCSl initiators (Node1 and Node2) and enable them to ac-
cess the iSCSI virtual disk. Follow these steps to add the servers one
at a time:
a. Select Add. The Add initiator ID screen appears.
b. Select Enter a value for the selected type.
c. From the Type drop-down menu, choose any of the following
options to enter a value:
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Section

What To Do

= If you select DNS Name, enter the DNS name of the
computer where the iSCSI initiator is installed.
= If you select IP Address, then enter the IP address of
the computer where the iSCSl initiator is installed.
= If you select Mac Address, then enter the MAC address
of the computer where the iSCSl initiator is installed.
d. Select OK to exit.
e. To add Node2, repeat the above steps.

Enable authentication

Skip to the next section.

Confirmation

Select Create.

When the iSCSI virtual disk is created successfully, select Close to exit the wizard.

6. In Server Manager, go to File and Storage Services > iSCSI and verify the newly created virtual disk
is listed under iSCSI virtual disks.

The virtual disk status appears as Not Connect ed. This occurs when a new iSCSI target is selected

during iSCSI virtual disk creation.

7. Right-click the Not Connect ed iISCSI virtual disk and select Assign iSCSI Virtual Disk.

8. Complete Assign iSCSI Virtual Disk Wizard with these options:

Section

What To Do

iSCSI Target

Select Existing iSCSI target and select the target server to connect.

Confirmation

Select Assign.

When the iSCSI virtual disk is assigned successfully, select Close to exit the wizard.

Initialize a Virtual Disk

This topic describes how to initialize a disk and create a volume.

Create a Virtual Disk (on page 94).

You need to perform the following tasks only once on any of the iSCSI initiator nodes and it applies to the

other nodes in a cluster. Suppose there are two nodes in a cluster, Node1 and Node2. If you initialize a

virtual disk on the Node1 server, then you don't need to do it again on the Node2 server.
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1. Log in to any of the server nodes in a cluster (Node1 or Node2).
2. Go to Control Panel > Administrator Tools > Computer Management > Storage > Disk

Management.
3. Look for the unknown disk, right-click and select Online.
If the unknown disk is offline, you must bring it online.

= Disk 1 e

Basic UaslSCSl (G:)
24.28 GB 2428 GB NTFS
Cnline Healthy [Primarny: Parbition)

Unkmniown
10,00 GB

opurz I
Stfiine ©

Propostaes

— CD-ROM O Help

D (Cx)
| B uUnallocated Il Primary partition

4. Right-click the unknown disk again and select Initialize disk.

= pisk 1 |

Banic (TP Lo )
24.28 GB Z4.28 GB NTFS
Chnlaria Haalthvy (Primary Partiton)

O Disk 2 |

L B oy

e
PG Irat
e
e *
& o o e T
VD (T Halp
L

The Initialize Disk screen appears.
5. Select OK.
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Initialize Disk >

ou must initialize a disk before Logical Disk Manager can access it.
Select disks:
| Disk 2

Use the following partition style for the selected disks:

MER (Master Boot Racord)
# GPT (GUID Partition Table)

Mote: The GPT partition style is not recognized by all previous versions of

Windows
o] oo

6. Right-click the unallocated space on the disk, and select New Simple Volume.

i

| Mew simpte volume.. |

I
: Driak 1 My Spanmed Vol me..
anic UnalSCSi (G
24,28 GB 24,28 GB MTFS St a R s
Cnline Healthy (Prirarny Partition) Parwr Birrered Volumes
= Diiak 2 —— Profrarties
Bagic
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9.98 GB 298 GB —._______———""""" P
Carllire Urnallocated
— CO-ROM O
DD (D)

B Unallscated [l Primary partiticn

The New Simple Volume Wizard screen appears.
7. Complete the steps in the wizard to create a new volume.
You need to:
o Specify the size of the volume you want to create in megabytes (MB).
o Assign a drive letter to identify the partition.
> Format the volume with default settings.

The newly created volume should appear under This PC on the logged-in machine.

Create a Cluster

This topic describes how to create a failover cluster.
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Install Failover Cluster Manager on the iSCSI initiator nodes. Refer to steps 1-4 in Configure iSCSI Initiator

(on page 91).

You can perform these steps on either Node1 or Node2. Suppose you perform these steps on NodeT1, they
are automatically applied to Node2.

1. Log in to the iSCSI initiator node.

2. Go to Start > Administrative Tools > Failover Cluster Manager.

3. In Failover Cluster Manager, select Validate a Configuration.
Before starting to create a cluster of nodes, you should validate whether the nodes that you are
adding to the cluster are compatible with the cluster hardware requirement. For more information,
refer to the Microsoft documentation.

4. Complete Validate a Configuration Wizard with these options:

Section What To Do

Before You Begin Skip to the next section.

Select Servers or a Clus- | Browse and locate the servers you want to add to the cluster. Refer to

ter Add Server Nodes for Validation (on page 99).
Testing Options Select Run all tests (recommended).
Confirmation Review the list of tests run on the selected servers. The number of

tests run are based on the roles installed on the server nodes.

Validating This process may take several minutes depending on your network
infrastructure, and the number of server nodes selected for valida-

tion.

Summary a. Select View Report.

b. Review Failover Cluster Validation Report and fix any failed
validations. You can ignore expected warnings. The validation
report should be free of any errors, otherwise the cluster setup
will not be successful.

c. Select Finish.

5. In Failover Cluster Manager, select Create a Cluster.
6. Complete Create Cluster Wizard using these options:

Section What To Do

Before You Begin Skip to the next section.



https://docs.microsoft.com/en-us/previous-versions/windows/it-pro/windows-server-2012-r2-and-2012/jj134244(v%3dws.11)
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Section What To Do
Select Servers Nodes were already added during validating the configuration
process.
Validation Warning Select No.

Access Point for Adminis- | Enter a unique name for your cluster. For example, hauaacl ust er

tering the Cluster

Confirmation Clear the check box for Add all eligible storage to the cluster.

Creating New Cluster This process may take a while as there are several checks that must
be run, and tests that are conducted while the system is configured.

Summary Select Finish.

Add Server Nodes for Validation

This topic describes how to select computers during validating a cluster configuration.

In the following steps, uaAAHANODEL (Node1 server name) and UAAHANCDE2 (Node?2 server name) are used as

example server nodes in a cluster.

1. On the Select Servers or a Cluster tab, select Browse.

1."‘ Validate a {i:-nligl,lmricﬂ Wirard o

Jj.'.:n"j Select Servers or a Cluster
.

Before You Begin To vakdate & set of servers, add the names of al the servers
— To test an edsting custer, add the name of the cluster or one of B8 nodes
Cluster
Erter name s
elected servers
< Previous Cancel

The Select Computers screen appears.
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2. Select Advanced.

Select Computers
Select this object type:
Computers

From this location:

duster.ge.com

Enter the object names to select (sxamples):

Check Hameas

3. Select Find Now.

Selact Computers

Select this cbiect type:
[Compuiers

[From this location:

Object Types...
chuster.ge.com Locations. .

Common Quenes

HNama Stans with -

Descrpton:  Stars with  ~

L] Disabled sccounts

Mon eapaning password

-
Days snce last logon: - ?ug‘
[ Search resubs: -
Harma In Folder

A screen appears prompting to enter the network credentials.

4. Enter the user name and password of the domain where the cluster validation is being performed,
and select OK.
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After successful login, you can see the associated nodes.
5. Select uaAAHANCDEL and UAAHANODEZ2, and select OK.
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6. Select OK to exit.
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Configure Role

This topic describes how to configure a highly available virtual machine.
In failover cluster technology, each highly available virtual machine is considered to be a role.

You can perform the following steps on either Node1 or Node2. Suppose you perform these steps on
Node1, they are automatically applied to Node2.

1. Log in to any of the iSCSI initiator nodes.

2. Go to Start > Administrative Tools > Failover Cluster Manager.

3. In Failover Cluster Manager, expand your cluster name and go to Storage > Disks.
The cluster name is the unique name entered when creating your cluster. Refer to step 6 in Create a
Cluster (on page 97).

4. Right-click Disks and select Add Disk.

The Add Disks to a Cluster screen appears.

5. Select the disk you want to add, and select OK.

6. In Failover Cluster Manager, expand your cluster name and select Roles.

7. Right-click Roles and select Create Empty Role.

The newly created role appears in the Roles pane with the name New Rol e.

8. Right-click New Rol e and select Properties.

The New Role Properties screen appears.

9. Enter a name for the new role, and select Apply.

You can assign the role to multiple node servers and set an order of preference.

For example, the new name is bemo Rol e.
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Mew Role Properties >

General Failover

Mew Role
Name:
Demeo Role|

Prefemed Cwners

Select the preferred owners for this clustered role. Use the buttons
to list them in order from most preferred at the top to least preferred
at the bottom.

[j uaahanode1
[] uaahanode2

Priorty: Medum
Status: Running
Node: uaahanode 1

10. Right-click beno Rol e and select Add Storage.

The Add Storage screen appears.
11. Select the storage that is already associated to the cluster, and select OK.
12. Right-click peno Rol e and select Add Resource > Client Access Point.

13. Complete New Resource Wizard with the following options.

Section What To Do

Client Access Point Enter a name. For example, hauaacl ust er

Make a note of this name. You need to provide the fully qualified do-
main name while installing Proficy Authentication. See step 3a in
Configure Proficy Authentication Installation (on page 107). For ex-

ample, hauaacl ust er. cl ust er. ge. comwherein cl ust er. ge. comis the




Proficy Authentication | 1 - Proficy Authentication | 104

Section What To Do

domain where cluster is installed. Make sure all the initiator nodes

are in the same domain name.

Confirmation The network name and IP address are displayed for confirmation.

(L ™\
Note:
After creating this resource, the IP address and the name
should be added to the host s file on the node servers config-

ured for high availability.

N\ J
Configure Client Access | Verifies the validity of the client access point settings and creates a
Point new resource.
Summary Select Finish.

s
P T — e
¥ Lasmme o e g = -

On the node servers configured for high availability, go to . . \ W ndows\ Syst enB2\ Dri ver s\ et c\ host s
and open the file in a text editor to add the network IP address and name as follows.

<i paddr ess> hauaacl uster.cl uster. ge.com

<i paddress>  hauaacl uster

In the above example, <i paddr ess> should be replaced with the actual ip address of your machine.

14. Right-click beno Rol e and select Add Resource > Generic Service.
15. Complete New Resource Wizard with the following options:
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Section What To Do
Select Service In the services list, select GE Proficy Authentication Toncat Wb
Servi ce.
Confirmation Skip to the next section.

Configure Generic Service | Skip to the next section.

Summary Select Finish.

16. Add the dependency service to role using properties of the added service, so that services restart
when switching the node (failover condition).

a. In Failover Cluster Manager, select the added service.

b. Select Properties.
J. et Chister Manages ¥ n
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The properties screen for that service appears.

c. Select the Dependencies tab, and select Insert.
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GE Proficy Authentication PostgreSQL Database Properties X
Advanced Policies Registry Replication
General Dependencies | Polices

Specify the resources that must be brought online before this resource can
be brought online:
ANDIOR Resource

e |Click here to add a dependency

No dependencies.

OK Cancal Apply

A row is added to specify our required dependencies.

d. From the drop-down, select the required resource one by one to be added as part of
dependencies.
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GE Proficy Authentication PostgreSQL Database Properties >
Advanced Policies Registry Replcation
General Dependencies Palicies
Speciy the resources that must be brought online before this resource can
be brought online:
ANDIOR Resource
| Cluster Disk 1
AMND IP Address: 10.181.251.217
» AND | Name: hauaacluster -

¢ |Click here to add a dependency

Inset || Delete

Cluster Disk 1 AND IP Address: 10.181.251.217 AND Name:

hauaacluster
OK \ Cancal Apply

e. After inserting the resource, select Apply and then OK.

Configure Proficy Authentication Installation

This topic describes Proficy Authentication installation setup in a high available environment.

For fresh installation, you can straightaway proceed with the procedural steps in this topic. But, if you
want to use an existing database, do the following before you start with the procedural steps:
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1. Copy your Proficy Authentication existing database (found in the Postgress database location)
from wherever installed to the shared drive created using the iSCSI server. When you copy, make
sure the cluster is pointing to the drive before copying the database. For example, if the cluster is
pointing to Node1, then copy the database to NodeT1.

2. Make a note of the location path where you copied the database in the iSCSI server. For example,
F: \ UaaConf . You need to provide this path for installing Proficy Authentication on Node1 and Node2

machines.

To install Proficy Authentication on the iSCSI initiators (Node1 and Node2), make sure the shared drive in
available on the node where you want to run the installation.

1. Log in to the iSCSI initiator Node1 server.
2. Open Failover Cluster Manager and verify that the cluster role is associated to the node where you

want to install Proficy Authentication.

Roles (1)

Hame Status Type DVLEer_No_:FE Priorty Information

7 Demo Role () Running Other (" uaahanode | \> Medium

~ -

hd L} Demo Role Prefemed Cramer

Name Status Information

Storage

# 4 Cluster Disk 1 #) Onine

If not, then follow these steps to associate the node server:

a. Right-click your cluster role and select Select Node.
The Move Clustered Role screen appears.

b. Select the Node1 server, and select OK.
Once the cluster is mapped to Node1, the shared drive is available on Node1.

3. Run Proficy Authentication installation setup, and provide these details for the respective screens:
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a. In All Host Names field, enter hauaac! ust er. cl ust er . ge. comas the leading hostname,

followed by any other hostname/s.

@ Proficy Authentication 2022

Host Names

To allow secure access to the hosted web applications, please prowi
host names [fully qualified domain names and others) of this server,
separated by comma.

All Host Mames: hauaaclusterchestern fe.comg Bl 3 localhost, 12 7£.000. 1 ophub-host

P irr'lary Hast Name: hataac |u5.1‘11-|'.|:h|5.EM.g_{l.Em'n

Motas:
Thee pramasny bost namie must be
IP addresses may be entered i p ant us ¥ cess web applications by IP sdo

- Ervircenmienit

Cancel

b. This step applies for associating existing database. Enter the iSCSI server shared drive
location path where you copied the Proficy Authentication database. Refer to the steps at
the beginning of this topic (on page 107).

For example, F: \ UaaConf

@ Proficy Authentication 2022
Customize Log Files and Postgres Data Locations

Log Files Base Folder: %ProgramData%\ProfcyAuthenticationLogs
Proficy Authentication Database Folder: | IEIREETET

Mote: leave database folder entries blank if no customization is needed.

Cancel Prensous
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4. Log in to the iSCSI initiator Node2 server, and repeat the above steps to install Proficy
Authentication on Node2.
5. After installing Proficy Authentication on both the nodes, copy the DATABASE_PASSWORD registry key
from the last installed node to overwrite the registry key in the first installed node.
For example, in the following scenario:
a. First Proficy Authentication is installed successfully on the Node1 machine.
b. Next Proficy Authentication is installed successfully on the Node2 machine.
Node2 is considered as the latest installation. Node1 is considered as the first installation. So,
copy the Node2 registry key and overwrite the Node1 registry key.
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Corngaatas’ HIEY LOCAL MACHINESOF TWARE(WOWS 12 Nedei Apadhe Soltmans Foundation) Procnen 205U Tosrmaat Pl et
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Chatys Eefln B Saveeay .o
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Sptup Va3 T
Vidware. In Ereoramant;
L WG N ) Natas claa
¥ I Apsche Soltwire Foundation LM CUOMF LR WV IF it T uiton]_Coy e
» | Peocns 20 LU DOMFIG_FILE =C ProgramalandE Frodoy Aullrbebon
w | saTomcat o
v Paamaben silicelasin
Wed
Log
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Shogp
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6. Copy and replace the uaA yani file from Node 2 (latest installation) to Node 1 (first installation).

The file is located here C:\ Pr ogr anDat a\ Prof i cy\ Profi cy Authentication\uaa-config

ITER -

“ e e -

=

ChProgramDetsy GE Profscy Austhesiticationusa -conliy

o Chuisck sooess

B Desitop - i
4 Downloads L ]
| usayrrl
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- Pictures -
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Pregdhustinle



Proficy Authentication | 1 - Proficy Authentication | 111

7. Copy server.crt and server. key from Node 2 (latest installation) to Node 1 (first installation).
The certificates are located here: C:\ Program Fi | es\ Profi cy\ Profi cy Authentication\httpd\ conf

\cert
- et - o "
e - 0
= - 4 GE » Prolicy Acthentication » Betpd 5 conf 3 e ~ F]
=
3 ek aooess
TR & becabiten
kcakent k
¥ Dowricads o S
2 Sivpion TA-DE-JOEF TASE  Sacuriy Cartificat 5 KR
i Doument  # ey M-06-2022 1859 KEY Fie A KR
= Pichues -

ol

8. After copying the certificates (to Node1), rename server. crt t0 server. pem

9. Open ﬁ Certificate Management Tool on Node1 from the desktop shortcut, and import the
certificates as follows:

a. For Certificate File, select the server. pemfile created in the earlier step.
b. For Key File, select the server . key file.
c. Select Import.
s GE Operations Hub Certificate Management Tool - 4
Server Catficate  Exemal Tt Messages

On this page, you can view and update the cediicate chain used by the main web server
You can use & localy generabed server cerificate. of impon one Bsued by a thind pary

Lecal Contificate

View Fern
Imported Certficate

View Remove
Centficate o Import
Centficate File: | C!\Lisers'\Administrator Desktop server pem Select Woew
Ky File |C:\Users'Administrator Desidop server kiey Select Clear
Pasgword _ | t0nky for PEX/P12 Fle)

You can mpor a cenificate (chain) fle in ether PEM format or PFXP12 format . Fthe contificate file
dees not contan the prvate ey, then you must provide a stlandalons key fle in PEM format.

() Use Local Certficate (®) Use mported Certficate Aoply

Close
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Prerequisites for Installing Operations Hub with External Proficy
Authentication

This topic describes how to install Operations Hub with external Proficy Authentication in a high available

environment.

Set up a high available environment. See Configure High Availability for Proficy Authentication (on page
89).

These steps apply for installing Operations Hub with external Proficy Authentication. The steps include
mandatory changes prior to installing Operations Hub on any highly available server.

1. Log in to the node server where you want to install Operations Hub.
2. Open a browser and enter htt ps: // hauaacl ust er. cl ust er. ge. com / securi t yadni ni strati onapp/

3. Select the lock icon next to the web address, and then select Connection is secure.

] }aumchﬁtw.(hlsler ge.com/securityadministrationap

hauaacluster.cluster.ge.com ®
#  Connection is secure *
& Conkies TR A
£ Site settings A

4. Select Certificate is valid.

#  hauaacster.duster.ge.com/securityadministrationapp/#;

@ Security x

& Connection is secure

b

B Certificate s valid

The issued certificate appears.
5. Select Certificate Path > View Certificate.



Gereral Details

Certification Path

Certification path

| UAAHANODE? Root CA 202206062043

Lol vashenoda?

Certificate stabus:
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View Certificate

is certificabe is Ok,

6. Select Details > Copy to File.
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Gereral | Details | Certificaticn Path
Show: | <Al > v
| =jeld valLe
[Cversion W3
[J5er &l <wimber e e FafeBT0e
[Dsignatre aljoritbm  sha2SERSA,
[ISignatre hash alg... sha2se
[Clssuer GE Customer, Cper.,
[ valid from 05 Jure 2022 05:30...
[Hvalid to 05 Jume 2027 05230,
[subject CE Customer, Oper.,
[Py il ke RSA (4719 Fitsi
Edlit Propartes Copv to Fila, .
K

The Certificate Export Wizard appears.
7. Select Next.
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£+ Certificate Export Wizard

Welcome to the Certificate Export Wizard

This wizard Felps wou copy certificates, certificate trust lists and certificate revacation
lists from a certificate store to your disk.

A cortificate, which i isoued by 8 certification authority, is 8 corfirmation of your idenkity
ad contairs information usad bo protect data or bo establish seaure nebwork corrections.
A certificate store ks the system area where certificates are kept.

To conbinue, click Mest.

“Nea ]| cance

8. Select Base-64 encoded X.509 (.CER), and select Next.

€ &* Certificate Export Wizard

Expart File Format
Certificates can be exported ina variety of file formats.

Sarbict B farmat you wearit o us:
(IDER erooded binary X509 [ CER)
(W) Barga-6d ereociiad X500 { CER)
() Cryptograpie: Message Synibas Standard - PKCS #7 Certificates ( P7B)

Irichude sl cortificates in it

& cortilicator oot IF oot
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9. Browse and specify the file location, and select Next.

£* Certificate Export Wizard

File to Enport
Specify the name of the file you want bo export

£il :
C:\sers\AciministrstorDownloackias_certificate cer

et Cancel

10. Select Finish.

=* Certificate Export Wizard

Completing the Certificate Export Wizard

o have successfully completed the Certificate Export wizand,

Youd have gpecified the Following settings:

Filie Msrne C:lsers)\ Administrator\Downloads)|_lsa_d
Expoort Kieys oy

Inchude all certificates in the certificabion path Mo

Flle Format Buarsedd Encodied X509 (* cer)

[ ]| o
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11. Rename Uaa_certificate.crt to Uaa_certificate. pem
12. Run Operations Hub installation setup, and provide these details for external Proficy Authentication

fields:
Proficy Authentication Base URL https://hauaacl uster.cl uster.ge. conf uaa
Admin Client ID adni n
Admin Client Secret Gei @21litc

@ GE Operations Hub 2022.4.1

Proficy Authentication Service

Configure a built-in or external Proficy Authentication instance
Use External Proficy Authentication:

Proficy Authentscation Base URL:

Admin Clsendt 1D:

Admin Chent Secret:

above.
the inpuls befo

Cancel Prevsous MNext

Operations Hub is installed successfully.

Customize Login Screen

This topic describes how to customize the Proficy Authentication login screen.

You can customize the company name, logo, favicon, and include additional text/links to appear on the

login screen.

1. Log in to Configuration Hub.
2. Go to Proficy Authentication > Custom labels.
The default login screen details appear.
3. Use the following fields to customize your login screen.

A quick preview appears on the DETAILS tab.
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Field

Description

Company Name

Name of the company that appears on the login homepage.

Company Logo

Select an image from your local system to upload as the company
logo. Accepted file formats are PNG and JPG/JPEG. The file you're
trying to upload cannot be larger than TMB.

o ™\
Note:
If you've uploaded a company logo up to 2MB in size in the
2023 version, upgrading to the 2024 version will not cause

any issues.
N J

Select “* to remove an existing image.

Square Logo

Select an image from your local system to upload as a favicon,
which appears on the browser tab. Accepted file formats are PNG
and JPG/JPEG. The file you're trying to upload cannot be larger than
TMB.

o ™\
Note:
If you've uploaded a square logo up to 2MB in size in the
2023 version, upgrading to the 2024 version will not cause

any issues.
N J

Select “* to remove an existing image.

Footer Legal Text

Use this space to enter any legal information.

Footer Links

To add hyperlinks, create a label and provide a URL to connect.
a. Select =+ to add a row.
b. Enter a label name.
c. Enter a URL for the label name.

=S
Select ] to delete existing labels.

4. Select Save to save the updates you made to the login screen appearance.

To undo the saved changes, select Reset. The login screen is reset to the previously saved

appearance.
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NAVIGATION % Custom labels-Proficy Authentication % Security-Proficy Aut.. X DETAILS

UAA Login Preview

v &= Proficy Authentication Company Name™

GE D ee

@ Security
Company Logo™

@ Custom labels GE Digit0|
Allowed Image Extensions: .png, Jpg, Jpeg. | Maximum File Size Limit: 1 MB

Select Im...  Image Available < Welcome!
Square Logo User Identifier
Allowed Image Extensions: .png, Jpg, jpeg. | Maximum File Size Limit: 1 MB o "
aSSWOTrt

Select Im...
SIGN IN
Footer Legal Text

copyright year

Footer Links

Label* t URL* Action

Thisis a footer link https://www.ge.com/ 0}

5. Restart GE Proficy Authentication Tontat Web Server to apply the changes.

Backup and Restore

This topic describes how to perform backups and restore the Proficy Authentication database.

( Note: )

Consider these restrictions while performing backup and restore:

* You can only restore data to the same host (or to a host with the same hostname).

« You should restore data to the same version of Proficy Authentication.

N J

For steps to create a backup, refer to Back Up the Proficy Authentication Database (on page 119).
For steps to restore a backup, refer to Restore the Proficy Authentication Database (on page 121).
Back Up the Proficy Authentication Database

This topic provides steps to create a backup of the Proficy Authentication database.

You must have administrative access to perform the steps.
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1. Log in to the machine where Proficy Authentication is installed.

2. Download the PowerShell scripts and unzip the file.

3. Open Windows 'Services Management Console' and stop the Proficy Authentication Toncat Wb

Server Service.

4. Launch Windows PowerShell as an administrator.

5. Use the command line to navigate to the location where the backup script file was downloaded.

6. Execute the following command to create a backup: . \ Backup_Pr of i cyAut hent i cat i on. ps1

For example,

C:\ User s\ Admi ni strator\ Deskt op> .\ Backup_Prof i cyAut henti cati on. psl

The PROFI CY_AUTHENTI CATI ON_BKP_YYYYMVDD- HHWES. zi p file is created and saved to C:\ Pr ogr anDat a

location.

The yyyymvoD- HHWES in the filename includes the respective backup's datetime value.

The following table details the files and folders selected by the PowerShell script and included in

the backup zip file. It provides information on each item, its default location on the system, and the

corresponding target location within the zip file.

cation\uaa-config

File/Fold- Default Location Target Folder
er Name
data-v13 C:.\ ProgranDat a\ GE\ Profi cy Authenti- [PROFI CY_AUTHENTI CATI ON_BKP_YYYYM
cati on\ uaa- post gres MDD- HHMIVSS\ uaa- post gr es
uaa. ym C:\ ProgranDat a\ GE\ Profi cy Authenti- | PROFI CY_AUTHENTI CATI ON_BKP_YYYYM

MDD- HHMVSS\ uaa- conf i g

uaa- ht't pd. conf

C:\ Program Fi | es\ GE\ Profi cy Authen-

tication\httpd\conf\app-specific.d

PROFI CY_AUTHENTI CATI ON_BKP_YYYYM
MDD- HHMVBS\ uaa- confi g

server. xm

C:\ Program Fi | es\ GE\ Profi cy Authen-

tication\uaa-tontat\conf

PROFI CY_AUTHENTI CATI ON_BKP_YYYYM
MDD- HHMVBS\ uaa- confi g

Certificate(if

exi st)

C:\ Progr anDat a\ GE\ Profi cy Authenti -
cation\cert-nmanager\extraca\l dap_-

SecAdm nSrv

PROFI CY_AUTHENTI CATI ON_BKP_YYYYM
MDD- HHMVBS\ uaa- confi g

keytab file(if

exi st)

C:\ ProgranDat a\ GE\ Profi cy Authenti -

cation\uaa-config

PROFI CY_AUTHENTI CATI ON_BKP_YYYYM

MDD- HHMVSS\ uaa- conf i g



file_downloads/proficy-authentication-backup-restore.zip
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Restore the Proficy Authentication Database

This topic provides steps to restore a backup on your system.
You must have administrative access to perform the steps.

The restore operation deletes everything from the current system database. Therefore, it is recommended
to take a backup of your current database before proceeding with the restore operation. This backup will
allow you to recover your current data in case you decide to cancel the restore operation. See Back Up the
Proficy Authentication Database (on page 119).

1. Log in to the machine where Proficy Authentication is installed.

2. Download the PowerShell scripts and unzip the file.

3. Open Windows 'Services Management Console' and stop the Proficy Authentication Toncat Wb
Server service.

4. Launch Windows PowerShell as an administrator.

5. Use the command line to navigate to the location of the backup file you want to restore.

6. Execute the following command to restore the backup: .\ Rest ore_Prof i cyAut hent i cati on. ps1 C
\ Pr ogr anDat a\ PROFI CY_AUTHENTI CATI ON_BKP_YYYYMVDD- HHMVSS. zi p

For example,

C:\ User s\ Admi ni strator\ Deskt op> .\ Restore_ProficyAut hentication. psl

C:\ Progr anDat a\ PROFI CY_AUTHENTI CATI ON_BKP_20240228- 143602. zi p

The database is restored.
7. Perform Set up Proficy Authentication (on page 4) to start using the restored database.

Troubleshooting: Restoring Active Directory User Login

If Active Directory user login fails after a restore, then check if any LDAP connection is configured in the

identity provider of the security plug-in. Do the following:

1. Navigate to the Security plug-in in Configuration Hub.
2. Open each LDAP connection, trust and save it again.

Troubleshooting Proficy Authentication

Error 431: Request Header Fields Too Large

The error indicates that the size of the HTTP request header exceeds the limit set by the server.


file_downloads/proficy-authentication-backup-restore.zip
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The 431 error can be a symptom of poor scopes administration. Ensure that you are following the
principle of least privilege when assigning scopes to users. By limiting the number of scopes assigned to
each user to only what is necessary, you can reduce the size of the request header. However, if you still
receive the error in spite of optimizing the user scopes, you can adjust the HTTP request header size in
the Tomcat server configuration. To do so, follow these steps:

1. Access the Operations Hub installation folder on your machine.

2. Navigate toi gp-t oncat / conf/ server. xm .

3. Inthe server. xm file, look for Catalina service Connector section and locate the field
maxHt t pHeader Si ze to modify its value.

The default value is 8192. Increase the size to a higher value, such as 16384 or 24576.

4. Save the changes to the file and close it.

5. Restart the GE perations Hub | QP Tontat Web Server service from the Management Console.

Windows Auto-login Error Logs

This topic describes Windows Auto-login success/failure scenarios.

User logs in successfully

Verify the uaa. | og if the TGT/Kerberos token is generated properly. It should start with YII. You can ignore
the lengthy token value in the log entries.

[ 2022-02-22 19:29: 41.949] cl oudf oundry-identity-server - 14188 [http-ni 0o-9480-exec-8] ....
DEBUG - -- SpnegoAut henti cati onProcessingFilter: Received Negotiate Header for request

https://w nl6-sachi n. uaat estad. ge. comf uaa/: Negotiate Yl | HVQYGKWY****x* %%

A local Windows (non-domain) user attempts Windows Auto-login (using query
parameter in the URL) from a domain member machine

Browser displays an error. The error message also appears in uaa. | og. The following error appears when

attempting to login with domain name in the URL.
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HTTP Status 500 — Internal Server Error

T Exception Report

(=TT Serviet.init() for serviet [spring] threw exception

[T The server encountered an unexpected condition that prevented it from fulfilling the request.
Exception|

javax.servlet.ServletException: Servlet.init() for servlet [spring] threw exception
org.apache.catalina.authenticator. AuthenticatorBase. invoke(AuthenticatorBase.java:s
org.apache.catalina.valves. ErrorReportValve. invoke(ErrorfeportValve. java:92)
org.apache. catalina.valves. AbstractAccessLogvalve. invoke(Abstractaccesslogvalve. jav
org.apache.catalina.valves. RemotelpValve. invoke(RemoteIpValve. java: 769)
org.apache.catalina.valves.rewrite.RewriteValve. invoke(RewriteValve. java: 289)
org.apache.catalina.valves.RequestFiltervValve. process{RequestFilterValve.java:378)
org.apache.catalina.valves. Remotedddrvalve. invoke( Remotedddrvalve. java: 56)
org.apache.catalina. connector. Coyotehdapter . service(CoyoteAdapter. java: 357)
org.apacthe. coyote. . httpll. HttpllProcessor. service(HttpllProcessor, java: 382)
org.apache.coyote.AbstractProcessorLight . process(AbstractProcessorLight. java:65)
org.apache.coyote.AbstractProtocol$ConnectionHandler. process{AbstractProtocel. java:
org.apache.tomcat.util.net.NieEndpoint$SocketProcessor . deRun{NicEndpoint . Java:1722)
org.apache.torcat.util.net.SocketProcessorBase . run{SocketProcessorBase. java:49)
org.apache. tomcat . util. threads . ThreadPoolExecutor . runkorker ( ThreadPoolExecutor . java
org.apache.tomcat . util, threads. ThreadPoolExecutorfdorker. run{ThreadPoolExecutor, jav
org.apache.tomcat.util. threads. TaskThread$WrappingRunnable.run( TaskThread. java:61)
java.base/java.lang.Thread. run{Unknown Source)

java.lang.IllegalStateException: Listeners cannot be added to context [fuaa] as the context
org. cloudfoundry . identity.vaa. impl . config. vamlServietProfileInitializer. initialize(
org. clovdfoundry. ident ity . uaa. impl.config. YamlServietProfilelnitializer. initialize(
org. springframework .web. servlet . FraseworkServlet, applyInitializers(FrameworkServlet
org. springframework . web. servlet . FrameworkServlet . configureAndRefreshWebApplicationd
org. springframework.web.servlet.FrameworkServlet.createkebApplicationContext(Framen
org. springframework . web. servlet . FrameworkServlet. createkebapplicationContext(Framew
org. springframework web. serviet . FraseworkServliet. initWebipplicationContext (Framewor
org. springframework . web . servlet . FraseworkServlet. initServietBean{FrameworkServlet. §
org. springframewors . web. servlet  HttpServletBean. init(HttpServletBean, java: 178}
javax.servlet.GenericServlet.init(GenericServlet. java: 158)
org.apache.catalina.authenticator. AuthentlcatorBase. invoke(AvthenticatorBase. java:s
org.apache.catalina.valves.ErrorReportvalve. invoke(ErrorfeportValve. java:o2)
org.apache.catalina.valves. AbstractAccessLogValve, invoke(AbstractAccesslogValve, jay
org.apache,catalina,.valves.RemotelpValve. invoke(RemoteIpValve. java: 769}
org.apache.catalina.valves.rewrite.RewriteValve. invoke(RewriteValve. java: 289)
org.apache.catalina.valves.RequestFiltervValve. process{RequestFilterValve.java:378)
org.apache.catalina.valves. Remotedddrvalve, invoke| Remotesddryvalve. java:56)

The following error appears when attempting to login with non-domain name in the URL.
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& HTTP Stabus 500 - Infernal Serve X -+

L ' & Notsecure | hitpsywin16-sachin/uaa/TUseKerbAuth=true

i ohpps 0 XU LOGN @) OpHub 254 I Autologin Uas 254

HTTP Status 500 — Internal Server Error

[T Sendetinit() for sendet [spring] theew exeption
[T The server encountered an unexpected cordition that preverted it from fulfilling the request.
Exception

javax.servlet ServigtException: Servlet.init{} for servliet [spring] threw exception
orgapache. catal ing, suthenticator. duthent icatorBase. irvoke(AuthenticatorBase, java;548)
org.apache.catalina.valves.ErrorReportValve. invoke(ErrorReportValve . java: 52)
org. apache. catal ina, walves abstractacces slogialve. invoke{dbstractaccesiLogvalve. fava: 687)
org.apache. catalina, valves Resctelpvalve . inveke(RescotelpValve. java: 769)
org.apache. catal ina. valves.rewrite Rewritevalve. invoke{Rewritevalve . java: 289)
org.apache. catalina, valves RequestFilteryalve. precess (RequestFiltervalve, java: 378)
org.apache. catal ina. wvalves . RemoteAddrval ve . invoke | Remotedddrvalwe . java: 56
arg. apache.catalina, comnector, Eﬂ,ﬂtl‘”dﬁltﬁlﬂ service[Coyotaddapter. j-&\'a 1357)
org.apache. coyote. httpll Httpllfrocessor . service{HttpllProcessor. java:382)
arg. apache, coyate, AbsTrac EP‘I‘D{!iSﬂI‘L]‘h‘E process{Abstras EPI‘D(!SMI‘L]SHE " jan-a.-. 65
arg.apache. coyote. AbstractProtocol$Connect ionHandler . process{AbstractProtocol . javaz895)
argapache. toncat  util.net. HioEndpoint$5et ketProcessor . doRun{NioEndpadnt. java:1722)
org.apache. tomcat . util net . SocketProcessorBase . run{SocketProcessorBase. Java 149)
org. apache. tomcat.util. threads . ThreadfoolEvecutor. runkorker| ThreadPool Executor. java:1191)
org . apache. tomcat, util  threads . ThreadPoo lExecutoriborker . run| ThreadPoolExecuter . Java:659)
org.apache. tomcat . util.threads . TaikThreaddurappingAunnable. runi{ TaskThread . javaz 61)
java.base/java. lang. Thread . run{Unkrown Source)

koot Causs

java.lang.IllegalstateException: Listeners cannot be added te context [fuaa] as the context has been imitialised
org.cloud foundry. identity. uaa. impl .config. YamlServletProfilelnitializer.initialize(YanlServletProfilelnitializer. favaz B8)
org. cloudfoundry. Identity. usa. iepl . config. vanlServletProfilelnitializer. initialize(YanlServietProfilelni tial izer. fava:54)
org.springframework . web. serviet.FrameworkServlet .applylnitializers{FrameworkServiet . javaz héd)
arf . Springfrastwork  web, serviet, FrasewerkServlet, conf ijureindRefreshidebippl icationfontext{FraseworkSery et fava: 7al)
arg.springframwork . web. servlet. Framewor kServlet . createsebappl icationContext( FrameworkServilet. java t668)
arg . ipringfrasework . web, serviet. Frasewor kServlet, createlebippl icationCont et [ FrameworkServlet, Java: 716)
arg.springfrasewori . web. serviet. FramoworkServlet . indteebappl icationContext( FrameworkServlet. javazs9l)
arg . ipringfrasework  web, serviet. Frasewor kServiet, initServietBean( Frasewor kServlet, favaz530)
org . springfrasework . web. serviet HttpServletBean. inlt{HttpServietBean. java:17a)
javax . fervlet GenerlicServlet  dnit{GenericServliet. favaz158)
org.apache. catalina, authenticator. AuthenticatorBase. irvoke(AuthenticatorBase. java:548)
org.apache. catal ina. wvalves . ErrorReportialve. invoke{ErrorReportvalve . Java: 5i)
arf.apache. cataling, va Ives . AbSTractAccess L-'}s"i'll\'e-. irvoke{Abstrac tﬂt{éiil{lﬂﬂlﬂ. favaz687)
org.apache. catalina. valves . Remotelpvalve . invoke| RemotelpValwe. java: 769)
argapache. catal ina, valves . réwrite, RewriteValve. invoke|Rewr itevalve . java: 289)
org.apache. catal ina. wvalves . RequestFiltervalve. process ([ RequestFllterValve. Java:378)
arg.apache. catal ina, walves . Remoteiddrval ve . invoke| Remotedddrvalve . java: 56)
1357%

Bad or missing keytab file (or) Bad SPN in uaa. yni file

The following errors appear in uaa. | og.

[2022-02-21 19:09: 21. 839] cl oudf oundry-identity-server - 13956 [http-nio-9480-exec-8] .... ERROR ---
Dynani cKer ber osAut hent i cati onManager: Kerberos validation not successful. Encountered Bad Credentials Exception :
Kerberos validation not successful

[2022-02-21 19: 09: 21. 839] cl oudf oundry-identity-server - 13956 [http-nio-9480-exec-8] .... ERROR ---
Dynami cKer ber osAut hent i cati onManager: Kerberos validation not successful. Encountered Bad Credential s Exception :
Ker beros validation not successful

[2022-02-21 19:09: 21. 839] cl oudf oundry-identity-server - 13956 [http-nio-9480-exec-8] .... ERROR ---

Dynani cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : null
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[2022-02-21 19: 09: 21. 839] cl oudf oundry-identity-server - 13956 [http-nio-9480-exec-8] .... ERROR ---
Dynani cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : null
[ 2022-02-21 19: 09: 21. 839] cl oudf oundry-identity-server - 13956 [http-nio-9480-exec-8] .... ERROR ---
Dynami cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Defective token detected (Mechani sm
| evel : GSSHeader did not find the right tag)
[2022-02-21 19: 09: 21. 839] cl oudf oundry-identity-server - 13956 [http-nio-9480-exec-8] .... ERROR ---
Dynani cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Defective token detected (Mechani sm
| evel : GSSHeader did not find the right tag)
[2022- 02-21 19: 09: 21. 839] cl oudf oundry-identity-server - 13956 [http-ni o-9480-exec- 8]
WARN --- SpnegoAut henti cati onProcessingFilter: Negotiate Header was invalid: Negotiate
Tl RMTVNTUAABAAAAI 4| | 4gAAAAAAAAAAAAAAAAAAAAAKADK 4 AAAADW==
org. springframework. security. aut hentication. BadCredenti al sException: Bad Credentials excpetion. It could be due to

keytab file and the SPN configuration.

Crypto Mismatch

A crypto mismatch occurs if the encryption algorithm specified while using kt pass. exe to generate keytab
does not match what is supported by the service account.

[2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynani cKer ber osAut hent i cati onManager: Kerberos validation not successful. Encountered Bad Credentials Exception :
Kerberos validation not successful

[2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynami cKer ber osAut hent i cati onManager: Kerberos validation not successful. Encountered Bad Credential s Exception :
Ker beros val i dation not successful

[2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynani cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : null

[ 2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynamni cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : null

[2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynami cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Failure unspecified at GSS-API
| evel (Mechanismlevel: Invalid argunment (400) - Cannot find key of appropriate type to decrypt AP-REQ - RC4 with
HVAC)

[ 2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynamni cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Failure unspecified at GSS-API
| evel (Mechanismlevel: Invalid argument (400) - Cannot find key of appropriate type to decrypt AP-REQ - RC4 with

HVAC)
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[2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynamni cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Invalid argunent (400) - Cannot
find key of appropriate type to decrypt AP-REQ - RC4 with HVAC

[2022-02-22 11:39:18.326] cloudfoundry-identity-server - 6084 [http-nio-9480-exec-3] .... ERROR ---
Dynami cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Invalid argunent (400) - Cannot

find key of appropriate type to decrypt AP-REQ - RC4 with HVAC

Clock skew between client and server

The following errors appear in uaa. | og.

[2022-02-19 13: 14:55.556] cloudfoundry-identity-server - 14532 [http-ni 0-9480-exec-9] .... ERROR ---
Dynami cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : null
[ 2022-02-19 13: 14:55.556] cl oudfoundry-identity-server - 14532 [http-ni 0-9480-exec-9] .... ERROR ---
Dynani cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : null
[ 2022- 02- 19 13: 14: 55.556] cl oudf oundry-identity-server - 14532 [http-ni 0-9480-exec-9] .... ERROR ---
Dynamni cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Failure unspecified at GSS-API
I evel (Mechanismlevel: Cock skew too great (37))
[2022- 02- 19 13: 14: 55.556] cl oudf oundry-identity-server - 14532 [http-ni 0-9480-exec-9] .... ERROR ---
Dynani cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Failure unspecified at GSS-API
I evel (Mechanismlevel: O ock skew too great (37))
[ 2022- 02- 19 13: 14: 55.556] cl oudf oundry-identity-server - 14532 [http-ni 0-9480-exec-9] .... ERROR ---
Dynami cKer ber osAut henti cati onManager: Root cause for Kerberos validation failure : Cock skew too great (37)
[2022-02-19 13: 14:55.556] cloudfoundry-identity-server - 14532 [http-ni0-9480-exec-9] .... ERROR ---

Dynami cKer ber osAut hent i cati onManager: Root cause for Kerberos validation failure : Cock skew too great (37)

Note:

Make sure the clocks on all the three systems are synchronized.

Useful SPN commands

To view existing SPNs | setspn -F -Q HTTP/ <FQDN>

Example: setspn -F - Q HTTP/ phant onhost . uaat est ad. ge. cOmM@JAATESTAD. GE. COM
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B Command Prompt

:\Users\User3>hostname
uaaautologin2

:\Users\User3>setspn -F -Q HTTP/uaaautologin2*

hecking forest DC=uaatestad,DC=ge,DC=com

N=spnUserSrvAcctAutoLogin2,CN=Managed Service Accounts,DC=uaatestad,DC=ge,DC=com
HTTP/uaaautologin2.uaatestad.ge.com

Existing SPN found!

To delete SPN

setspn - D HTTP/ <FQDN> <user account >

Exanuﬂe:setspn - D HTTP/ phant omhost . uaat est ad. ge. COmM@QJAATESTAD. GE. COM

ghost 1

How to Un-Register an Existing Service Principal Name (SPN)

The following steps ensure the un-registration of the existing SPN and the necessary updates in Active

Directory.

Step 1: Delete Any Oth-
er SPN (if exists)

Run the command set spn - D HTTP/ t henaneyougavet ot hespn spnUser Nane

Replace:

* t henaneyougavet ot hespn with the SPN you want to unregister
* spnUser Nane with the user who created the SPN being un-registered.

Select Command Prompt

C: \Users\User3>setspn -D HTTP/uaaautologin2.uaatestad.ge.com@UAATESTAD.GE.COM spnUserAutolLogin2

Unregistering ServicePrincipalNames for CN=spnUserSrvAcctAutologin2,CN=Managed Service Accounts,DC=uaatestad,DC=ge,DC=com
HTTP/uaaautologin2.uaatestad.ge.com@UAATESTAD. GE . COM

Updated object

C: \Users\User3>_

Optional step: Verify
Un-Registration

Run the command set spn -F -Q HTTP/ t henaneyougavet ot hespn*

Step 2: Update Logon
Name in Active Direc-

tory

1. Go to Active Directory.
2. Open the properties of the existing spnuser Nane.
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spnUserSrvAcctAutologin2 Properties ? X

Organization Published Certificates Member Of  Password Replication
Dialin Object Security Environment Sessions
Remote control  Remote Desktop Services Profle =~ COM+  Attribute Editor
General Address Account Profile

Telephones  Delegation

User logon name

HTTP) in2.uaatestad.ge.c ge.com

User logon name (pre-Windows 2000, ¢

UAATESTADO spnUserAutaLogin2

Logon Hours.. Log On To...

Unlock account

Account options:

[[J User must change password at next logon il
[] User cannot change password

[ Password never expires

[] Store password using reversible encryption v
Account expires

® Never

() End of: 16 December 2023

[Cancel Apply Help

SAMAccount Nane or User logon name (pre-Windows 2000).

spnUserSrvAcctAutoLogin2 Properties

Organization  Published Certificates ~ Member Of

Diakin Object Security

Remote control  Remote Desktop Services Profile

General  Address  Account  Profile

User logon name
spnUserAutoLogin2]

User logon name (pre-Windows 2000):
UAATESTADOV

Logon Hours... Log On To...

Unlock account

Account options:

3. Change the logon name from HTTP/ uaaaut ol ogi n2. uaat est ad. ge. comto

2

Environment Sessions
COM+  Attribute Editor
Telephones  Delegation

@uaatestad.ge.com

spnUserAutoLogin2

[[] User must change password at next logon
[v] User cannot change password

[+] Password never expires

[] Store password using reversible encryption

Account expires

® Never
() End of: 16 December 2023

Apply Help

Resolving JWT Token Size and Autologin Challenges

When a user is assigned to many groups, there are issues with JWT token size, leading to rejection of
requests by Tomcat due to the exceeded header size limit. Additionally, there are problems configuring

autologin and logging into Operations Hub with the autologin feature, resulting in a "Bad Request" error.

This issue arises when a user is a member of many Active Directory user groups. The size of the HTTP
request header, which contains the Kerberos token in the WWW-Authenticate header, increases with the

number of user groups. If the header size exceeds the server-configured limits, the server rejects the

request.

To resolve the issue, do the following:

Update HTTPD Configu-

ration File

text editor.
2. Add the following code:

Li mi t Request Fi el dSi ze 16384

#SPNEGO aut henti cati on HTTP request header size

3. Save and close the httpd configuration file.

1. Visit the location C:\ Program Fi | es\ GE\ Profi cy Authentication\httpd

\ conf\ app- speci fi c. d\ uaa- ht t pd. conf and Oopen uaa- ht t pd. conf ina

Password Replication




Update Tomcat Configu-
ration File
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1. Visit the location C:\ Program Fi | es\ GE\ Profi cy Authentication\uaa-
tontat\conf\server.xm and open server. xn in a text editor.
2. Locate the Connector element and change the maxHt t pHeader Si ze at-
tribute.
Change nmaxHt t pHeader Si ze="8192" to maxHt t pHeader Si ze="16384".
<Connect or connectionTi meout ="20000" redirect Port="8443"
port="9480" neaxPost Si ze="2097152" naxHt t pHeader Si ze="16384"
prot ocol ="HTTP/ 1. 1" ></ Connect or >
3. Save and close the tomcat configuration file.
(o
Note:
» The default value for the header size is Li ni t Request Fi el dSi ze
8192 bytes (8k).
» The default value for maxHt t pHeader Si ze is 8192.
-

Issue: Duplicate LDAP User Creation in Proficy Authentication Database

This topic describes potential LDAP IDP configuration choices that may lead to the issue and offers

guidance on how to avoid it.

The issue can occur when using multiple LDAP IDP configurations, especially in scenarios involving 'multi-

domain support' introduced in version 2023.

Leveraging Multi-Domain Support

The introduction of 'multi-domain support' aimed to allow the configuration of multiple LDAP IDPs,

primarily to support user authentication and authorization across different domains (multiple LDAP

servers) through a single instance of the Proficy Authentication service.

Secondary Usecase: The 'multi-domain support' feature can also be utilized to configure multiple LDAP

IDPs for a single domain (single LDAP server). This is often done when dealing with large domains with

users spread across the directory structure.

Problem Scenario: A potential challenge arises when selecting a single User or Group Search Base in

the IDP configuration. This choice may lead to a generic scope, resulting in timeout errors during user
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authentication. The issue stems from the extensive search scope for both User and Group searches. To
avoid these timeout errors, it is crucial to carefully consider and configure the User and Group Search
Base values to align with the specific structure and distribution of users within the targeted domain.

Solution: When setting up multiple LDAP IDPs targeting a single domain or LDAP server, ensure that
the 'User Search Base' values across the IDP configurations are distinct. In other words, a user from the

configured domain should not be found in more than one LDAP IDP.

Neglecting this precaution can result in a user being authenticated from multiple LDAP IDPs, leading to
the creation of multiple user records with different 'origin' names in the UAA Database. This situation can
further cause authorization issues in applications like Operations Hub (or any other client application) if

authorization selections are made at the individual user level rather than for user groups.
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